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Reach Us On the Web

Idaho Technology’s Web site is - http://www.idahotech.com
We strongly encourage users to visit our Web site for answers to frequently

asked questions, updated information and additional insights into operating
the LightScanner System.

Reach Us By E-mail
You may contact Idaho Technology by e-mail. The e-mail should give us contact information, such
as your phone number and address and whether you want us to send you e-mail in response. It

should also include information such as the name of the product and the serial number.

If you have technical questions, want to schedule maintenance or repair, or you need a return
material authorization, please send us an e-mail at:

support@idahotech.com - Customer Support

If you want information about sales, pricing, or quotes, or if you have questions about your order,
please send us an e-mail at:

it@idahotech.com - General Support

Reach Us By Phone

Technical support is available during the following times:
8 a.m. to 5 p.m. - Mountain Standard Time

For technical support call:

1-800-735-6544 - Toll Free (United States and Canada)
(801) 736-6354 - Utah

+1-801-736-6354 - International

Reach Us By Fax

To contact Idaho Technology by fax, use the following numbers:
1-801-588-0507 - United States and Canada
+1-801-588-0507 - International
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The following symbols can be found throughout this manual. Use the definitions below as a
guideline to their interpretation.

This symbol is used to indicate that non-compliance with instructions or
procedures may lead to injury or even death.

This symbol defines a potentially hot surface. Use caution when working near
these areas to avoid bodily injury. Keep flammables and combustibles at a safe
distance.

This symbol warns the user to operate the instrument according to the instruc-
tions provided in this manual. If used otherwise, a potentially hazardous situa-
tion could result.

This symbol highlights user tips to operate the instrument more efficiently.

> B>
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BSA. bovine serum albumin

CCD e charge-coupled device

COMP ... current good manufacturing practice

DHPLC ..o denaturing high-performance liquid chromatography
DMSO ..o dimethyl sulfoxide

DNA deoxyribose nucleic acid

DT T dithiothreatol

EDTA oo ethylenediaminetetraacetic acid

HEPES ... 4-[2-hydroxyethyl]-1-piperazineethanesulfonic acid
HPLC .. high-performance liquid chromatography

N I PR Idaho Technology, Inc.

LED .o light emitting diode

MOPS ... Tris, 3-[N-morpholino] propanesulfonic acid
NAGS ..o N-acetylglutamate synthase

PCR e polymerase chain reaction

SAG ... small amplicon genotyping

SNP single nucleotide polymorphism

TGCE...ci e temperature gradient capillary electrophoresis
TE e Tris ethylenediaminetetraacetic acid

T e melting temperature

TMSO e tetramethylsulfoxide sulfolane

UNG.. ..o uracil-DNA glycosylase

UVIVIS ..o ultraviolet-visible
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The LightScanner is designed to perform Hi-Res Melting™ of amplified nucleic acids. The result-
ing data can be used for mutation scanning or genotyping.

This instrument is intended for general laboratory use and should only be operated by trained lab-
oratory professionals. Users are expected to have carefully read all the training material before
beginning LightScanner operation.

This End-User License Agreement (EULA) is a legal agreement between you (either an individual
or an entity) and ldaho Technology, Inc. (Idaho Technology), the manufacturer of the LightScanner
system. If you do not agree to the terms of this Agreement, you may not install, use or copy

the SOFTWARE contained in this product and you must promptly contact Idaho Technology for
instructions on return of the entire LightScanner System and SOFTWARE for a refund.

1. Ownership of the Software

This SOFTWARE and the accompanying written materials are owned by Idaho Technology and
are protected by United States copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties. The SOFTWARE is licensed, not sold.

2. Grant of License

Idaho Technology grants to you a LICENSE to install and use the SOFTWARE on one or more
computers, provided that all users are at a single working location. Use of the SOFTWARE

at multiple working locations will require a separate License for Multi-site Use from Idaho
Technology for each additional working location.

You may not copy the SOFTWARE onto a portable diskette or storage device except for one
copy of the SOFTWARE in machine readable form solely for backup purposes, provided you
reproduce ldaho Technology’s copyright notice and any proprietary legends. You may not copy
the written materials.

3. Restrictions on Use and Transfer

You agree to secure and protect the SOFTWARE and any copies in a manner consistent
with the maintenance of Idaho Technology’s rights in the SOFTWARE and to take appropri-
ate action by instruction or agreement with other users who are permitted access to the
SOFTWARE in order to fulfill your obligations under this LICENSE.

You may permanently transfer the SOFTWARE and accompanying written materials (includ-
ing the most recent update and all prior versions) provided (1) you retain no copies and (2) the
transferee receives this Agreement AND agrees to be bound by its terms. Such a transfer ter-
minates your license.

You may not export or re-export the SOFTWARE or any underlying information or technology
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except in full compliance with all United States and other applicable laws and regulations.

You may not rent, lease or loan the SOFTWARE or otherwise transfer or assign the right to
use the SOFTWARE, except as stated in the preceding paragraph. The SOFTWARE may
contain trade secrets and in order to protect them, you may not decompile, reverse engineer,
disassemble, or otherwise reduce the SOFTWARE to a human-perceivable form, in whole or
in part. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RESELL FOR PROFIT, DISTRIBUTE,
NETWORK OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY
PART THEREOF.

Limited Warranty

THIS SOFTWARE IS PROVIDED BY IDAHO TECHNOLOGY INC. “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL IDAHO
TECHNOLOGY INC. BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Termination

Without prejudice to any other rights, Idaho Technology may terminate this LICENSE if you fail
to comply with the terms and conditions of this LICENSE. In such event, you must destroy all
copies of the SOFTWARE and all of its component parts.

For questions concerning this license or this limited warranty, you may contact Idaho
Technology by writing to: LightScanner Software License Services, ldaho Technology, Inc.,
390 Wakara Way, Salt Lake City, UT 84108, USA.

Idaho Technology makes no warranty of any kind with regard to this material, including, but not
limited to the implied warranties of merchantability and fitness for a particular purpose. Idaho

Technology shall not be liable for errors contained herein or for incidental consequential damages
in connection with the furnishing, performance or use of this material.
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Chapter 1: Installing the LightScanner Instrument

This chapter contains technical information about the LightScanner® instrument, including specifi-
cations, installation requirements, and installation instructions. It is included for people who install
and maintain the LightScanner.

The LightScanner system consists of a single-temperature regulated heat block positioned under
a high resolution charge-coupled device (CCD) camera. Polymerase chain reaction (PCR) is per-
formed separately on a thermal block system before melting curve analysis on the LightScanner.
The fluorescent DNA-binding dye (LCGreen® Plus) is included in the PCR reaction, eliminating
post-PCR manipulation and reducing the possibility for amplicon contamination. A 96- or 384-well
PCR plate is loaded into the LightScanner and analyzed with the help of the LightScanner soft-
ware. The plate format you use depends on the LightScanner. Instruments configured for 96-well
plates cannot be used with 384-well plates and vice versa.
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Using the system improperly may compromise the integrity of the data, result in poor perfor-
mance, or even permanently damage the equipment.

On delivery, please check that all listed items are included. If you notice any discrepancy or ship-
ping damage, please contact Idaho Technology (ITl) immediately.

The components of the LightScanner System are listed in the following table. Please
note that these components may vary from country to country.

Component

Description

System Component 1

LightScanner Instrument 96-well plate format Catalog No.
LCSN-ASY-0011 or 384-well plate format Catalog No. LCSN-
ASY-0001.

System Component 2

LightScanner software package with CALL-IT® software and
LightScanner Instrument Operator’'s Manual. Cable (serial) to
connect LightScanner Instrument to the computer, cable con-
necting camera to computer, power cord (U.S.) or power cord
(E.U.).

Computer Hardware*

2 X 512 MB RAM 80 GB hard drive, CD-RW drive, network
card, keyboard, and PS/2 mouse.

Operating System

Microsoft® Windows XP Professional

Monitor*

17" Monitor with 1280 x 1024 graphics resolution

*Computer specifications may change

Product Specification
Size 7.8" (20 cm) width x 16.5" (42 cm) depth x 31.8
(81 cm) height
Weight 25 kg/55 Ib

Sample format

Standard 96- or 384-well tray (white), reaction
volume 5-100 uL

Data output

Plots melting profiles as fluorescence signal
intensity vs. temperature.

LightScanner Software

Accurately performs mutation scanning and
genotyping by Hi-Res Melting™ curve analysis.

Computer Pentium-based PC with 17" monitor and soft-
ware.
Networking Ethernet connection allows export of data in

standard spreadsheet format compatible with
SQL*LIMS® software.

Voltage Input

100-240 VAC, +/-10%, 50-60 Hz with automatic
detection and configuration, 2.5 A
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Chapter 1: Installing the LightScanner Instrument

Product Specification
Wattage 800 W maximum including computer and monitor.
Excitation filter 470 +/-20 nm
Emission filter 1 510 nm
Emission filter 2 (optional) 600 nm
Excitation Source Two sources illuminating target tray
Peak Excitation wavelength 470 nm
Sample temperature range 40 to 100 °C
Cooling time 95 to 60 °C (nonlinear) ~180 sec. at ambient temperature 25 °C
Heating rate 0.1 °Cl/s
Single run time 15 min., including cool down.

A Always observe these precautions when using the LightScanner Instrument:
» Follow all safety instructions printed on, or attached to, the analytical instruments.
» Observe all general safety precautions, which apply to electrical instruments.
*  Never touch switches or power cord with wet hands.
* Do not open the housing of the LightScanner.
* Do not open the LightScanner during operation.

* Always wear safety goggles and gloves when dealing with toxic, caustic, or potentially
infectious materials.

*  When analyzing infectious material, use the LightScanner only in specially equipped
rooms with controlled exhaust equipment, e.g., biological safety cabinets. Handling and
disposal of infectious material should be performed according to local safety guidelines.

A\ CAUTION: The heat block is hot while the instrument is operating.

@ Note: Only authorized service personnel should perform service or repairs required for this unit.

This section explains the requirements for placing, installing, and using the LightScanner instru-
ment and the LightScanner computer.

Installation Requirements
A\ Precautions for installation:

* Do not place the LightScanner next to instruments that cause electromagnetic interfer-
ence or have high inductance (e.g., centrifuges or mixers).
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»  Peripheral instruments connected to the LightScanner System must meet the IEC 950
(UL 1950) standard.
* Use only the supplied power cord and RS 232 connector.

* All plugs used in the LightScanner System (PC, printer, monitor) should have the same
phasing to prevent switch-on peaks and electronic noise generated by other instruments
or by the power supply itself. We recommend using a dedicated multiple-outlet surge
protector for the LightScanner System.

* Do not use the instrument in an explosive atmosphere.

Space and Power Requirements

Place the instrument in a site that can support the following instrument requirements:

Component Specifications

Dimensions The dimensions of the LightScanner are: 7.8" (20 cm) width x 16.5"
(42 cm) depth x 31.8" (81 cm) height. At least 7" of clear space is
required on the left side of the LightScanner instrument to provide
easy access to the emission filter selection bar.

Weight Approximately 55 Ibs (25 kg)

Voltage Requirements | The LightScanner operates between 110 and 240 V (50-60 Hz).
Make sure that a minimum voltage of 110 V is available for running
the instrument.

Note: The LightScanner adjusts automatically to the available
voltage when the instrument is plugged in. The user does not have
to set the instrument to the correct voltage manually. However, the
PC does not automatically adjust to available voltage. The user must
select appropriate voltage depending on the power source. Do not
open the LightScanner housing.

Power Consumption 100-240 V, 50-60 Hz, 800 W maximum including computer and
monitor.

Environmental Parameters

The instrument requires the following environment for accurate operation:

Description Specifications

Ambient Temperature 15t0 35 °C

Ambient Temperature Required to 18 to 30 °C

Maintain Specifications During Operation

Humidity 20-80%, no condensation
Altitude Sea level to 2000 m
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Storage Conditions

Chapter 1: Installing the LightScanner Instrument

The LightScanner can be shipped and/or stored under the following conditions:

Description

Specifications

Ambient Temperature

-10 to +60 °C

9 Note: Transport the instrument by placing your hands under the base of the instrument.
Position the instrument on the workbench. Allow 10 cm spaces to the left, right, and behind the
instrument to insure sufficient cooling of the electronic components. Follow the procedures below
to install the instrument and the computer successfully.

@ Note: We recommend connecting the LightScanner, PC, monitor, and printer to the same
grounded power suppply.

@ Note: Ensure that PC and monitor have been set to the correct voltage. Do not place the
instrument in direct sunlight or close to radiators or heating devices.

Serial Port

Camera Port

LightScanner Instrument

Air Exhaust

Indicator Lights —»Z

Emission Filter
Slide [igms;:anner‘

3

Sample Plate Slot —»\

Bar Code Reader —>»
Power Switch  (384-well system only) «

Air Intake

Back and Front of the LightScanner

System Manual
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Chapter 1: Installing the LightScanner Instrument

Power Cord

The LightScanner is provided with an IEC power cord equipped with a power plug that matches
the destination country’s standard power outlet or socket. The power cord has three pins: Live,
Neutral, and Earth/Ground. Some outlets or sockets (especially in countries that use the CEE7/7
plug) may allow the Live and Neutral pins to connect and leave Earth/Ground pin unconnected.
This should be avoided.

The Earth/Ground pin is provided for the safety of the user. Under fault conditions, the Earth/
Ground connection can help prevent accidental electrical shock. For safety, please ensure that
the Earth/Ground Pin has a reliable connection to the outlet’'s Earth/Ground pin and the outlet is
properly wired. If in doubt, consult with the personnel in charge of the building's electrical facilities
or have a certified electrician inspect the outlet.

CEE7/7 Plug

Earth/Ground Pin

IEC Power Plug
IEC Cable with CEE7/7 Power Plug

Connecting the LightScanner

<18>

© N ook w

Make sure the power is OFF on the LightScanner.

Connect the cables to the instrument (all on the back panel) in the following order:

a. Power cord

b. Camera cable

c. Serial cable

Connect the camera cable to the computer tower (connection on the bottom of the tower).
Connect the serial cable to the computer.

Connect the remainder of the computer cables (monitor, mouse, power etc).

Next plug in the power cords from the LightScanner and computer to the wall power source.
Turn on the computer.

Turn on the power switch on the back of the LightScanner instrument. You will hear two
beeps, the sound of a fan and the GREEN power light on the front of the instrument will turn
on.

You are now ready to run the LightScanner.
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Chapter 1: Installing the LightScanner Instrument
Connecting the Computer with the Camera

When you first connect the LightScanner computer to the instrument you will see a message indi-
cating that the computer has found new hardware. You will need to go through a simple 3-step
wizard to allow the computer to begin communicating with the LightScanner camera. Please fol-
low the instructions below:

Step 1

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
‘windows will zearch for current and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows | pdate "#'eb site [with your permizsion).

Bead our privacy palicy

Can‘windows connect to 'Windows Update to search far
software?

() e, this time arly
() fes. nowe and gvery time | connect a device

@%

Click Mest to continue.

Mext > l [ Cancel

Step 2

Found New Hardware Wizard

This wizard helps you install software for:

Photometrics 1394 Camera

\) If your hardware came with an installation CD
&2 or floppy disk. insert it now.

what do you want the wizard to do?

() Install rom a list or specific location [Advanced)

Click Mest to continue.

< Back H Mest » l[ Cancel
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Chapter 1: Installing the LightScanner Instrument

Step 3

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finished instaling the software for:

@ Photometrics 12394 Camera

Click Fimish to cloge the wizard.

The installation is now complete. Continue to the next step of the LightScanner setup, the
Camera check (see manual for instructions).

Camera Check

A quick check to confirm that the camera is communicating with the computer should be per-
formed.

Open the camera software found under:
Programs >> Photometrics >> RS config

1. Atable will open displaying a NAME in the Camera 1 box, usually “Camera 1” confirming
that the camera is communicating with the computer.

2. If there is not a name displayed and the boxes are gray, it indicates that the computer is not
communicating with the camera. If this is the case, please contact Idaho Technology techni-
cal support.

3. Open the following program:
Programs >> Photometrics >> Pvcam test

4. Select Collect Image. This will generate an image of the heat block confirming that the cam-
era is working correctly.

5. Once you see the image, click Done.

Calibration

After an instrument is installed, a plate position calibration will need to be performed. This calibra-
tion is performed in the Run window and requires a new, clean, completely empty plate.

1. Double-click on the LightScanner icon on the desktop.
2. Choose the Run tab.

3. Insert the empty plate into the instrument, notched edge first. The instrument should beep
when the plate is loaded and the door closed.
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4. Go to the Tools menu and select Calibrate Map.

Chapter 1: Installing the LightScanner Instrument

5. Animage of a plate with cross-hairs will appear. The cross-hairs can be moved using the

mouse.

@ Note: Instructions for calibration are also at the top of the screen.

a. First move the cross hairs
over the center of the well
at the top left corner (A1)
making sure the cross is
in the middle of the well
(sometimes this is not the
brightest part). Right-click
and select Enter.

b. Next, repeat with the top
right well (A12).

c. Lastly, repeat for the
bottom left well (H1).

d. The software should
produce an image of the
plate where every well is
ringed by a pink line.

e. Confirm that the positions
of the wells are not
skewed.

6. If you are not happy with

the results of the calibration,

repeat with a different plate.

Sometimes adhesive material

from the film may produce

pink streaks on the lip of a

well. If this happens, repeat

the calibration using a differ-
ent plate.

Calibrate in the
following order

Cross hatch is
over the center
of the circle,
and not on the
darkest part of
the well

When finished,
the pink circles
need to be
centered
around each
well. This
image shows a
good example
of a calibrated
plate
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7. Calibration should be repeated if the instrument is moved to a new location.

8. Weekly or monthly recalibrations are not necessary. It is only to be done the first time the

instrument is set up or after it has been moved.

The LightScanner consists of a temperature-regulated heat block positioned under a high-reso-
lution CCD camera. PCR is performed in 96- or 384-well format plates on a thermal block before
melting curve analysis on the LightScanner. The plate is then loaded into the sample plate slot of
the instrument. A stepper motor lifts the plate to a precise location so that a uniform focal length
is maintained. Banks of LEDs excite the fluorescent dye in the plate wells. The temperature in the
block is then slowly and consistently increased. A structural grid ensures the sample plate will not
warp during this slow heating. The high-resolution CCD camera captures fluorescence and the
data are transferred to the computer for analysis by the LightScanner software. A built-in bar code
reader provides the option of sample tracking and documentation as necessary.

LightScanner Instrument < > System Manual
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Chapter 1: Installing the LightScanner Instrument

Three indicator lights are located at the front of the LightScanner. All of the lights come on when
the instrument is switched on. During instrument operation, the lights function as described in the

table below:
Position of Light | Color of Light | Label Function | Indication
Top Green Power on On Instrument is switched on
Off No power, instrument is
defective
Middle Red Running On Instrument is running
Bottom Yellow Run Completed | On Instrument is not running

either because the run

is completed or because
the run has not yet been
started. Plate can be safely
removed.

Off Instrument is running.

Cleaning and Decontamination

@ Note: Before cleaning, ensure all electrical plugs are disconnected.

Clean the external parts of the instrument with a sponge moistened with the minimal amount of
water containing a mild detergent. The emission filters can be wiped free of dust using a clean,
dry, lint-free optical cloth.

If spills or leaks occur inside the heat block area, please contact an ITI representative. Do not
attempt to disassemble the LightScanner to gain access to this area.
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Chapter 2: Hi-Res Mutation Scanning

High Resolution Melting (Hi-Res Melting™) of nucleic acid depends on
the ability to collect high-density information of fluorescence as a func-
tion of temperature in a mixture that contains a fluorescent double-strand
DNA binding dye LCGreen Plus and PCR product. In the LightScanner,
images of DNA melting (i.e., fluorescence) are captured by a CCD
camera and magnified to reveal subtle details in DNA melting profiles.
Sample-to-sample comparisons of these images are then used to inter-
rogate the sequences of the amplified DNA. Correct interpretation of the
data depends to a large extent on the software algorithms that are used.
LightScanner software has been developed specifically to provide the most
accurate analysis of Hi-Res Melting curves.

This section will cover the basic concepts of Hi-Res Melting and mutation scanning using
LCGreen Plus dye.

Screening amplified DNA for sequence variation, also known as “mutation scanning”, is an impor-
tant tool for genetic research and clinical applications. The LightScanner is unique in that it allows
homogeneous mutation scanning in standard micro-titer format, using a saturating dsDNA
binding dye and Hi-Res Melting.

Mutation scanning techniques detect the presence of sequence variation in a fragment of ampli-
fied DNA. With a diploid genome, equivalent PCR fragments are generated from maternal and
paternal chromosomes. The DNA fragments are analyzed for completely matched hybrids called
homoduplexes, and mismatched hybrids called heteroduplexes. Conventional scanning tech-
niques are not homogeneous and require a separation step to identify heteroduplexes.

Mutations in PCR products are detected by changes in the shape of the melting curve compared
to a reference sample. Below are examples of single nucleotide polymorphisms (SNPs) identified
in two exons using the LightScanner instrument and our LCGreen Plus Dye. Superior reproduc-
ibility is demonstrated by the overlapping curves of duplicate samples for both the wild type and
the mutant samples.
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The LightScanner uses the fluorescence of a new category of dsDNA binding dyes, the LCGreen
dyes, to identify sequence variations without the need for dye-labelled probes. The system
requires no post-PCR addition of reagents or the need for separation. The LCGreen Plus dye is
included in the amplification reaction, and a Hi-Res Melting profile, requiring only 2-5 minutes,
reveals sequence variations.

Hi-Res Melting analysis with the dye LCGreen Plus identifies heterozygous single-base changes
in PCR products with a sensitivity and specificity comparable or superior to non-homogeneous
techniques. Variants are detected independent of their position within the fragment. Sensitivity

is highest in fragments 400 bp or fewer but scanning has been successfully performed with
fragments up to 1000 bp. In addition to identifying anonymous heterozygous variants, Hi-Res
Melting can often identify the specific mutation, in such cases scanning and genotyping can
often be combined into one simple melting analysis. A more difficult application is the identifica-
tion of homozygous sequence alterations; most other mutation scanning methods are unable to
distinguish these alterations from wild type sequences. By contrast, Hi-Res Melting has been
shown to be capable of identifying homozygous sequence alterations in several different types of
amplicons. Certainly, not all homozygous changes can be detected this way, but many will be.

Hi-Res Melting analysis relies on a new family of dsDNA binding dyes called LCGreen. The
unique feature of LCGreen is the ability to detect the presence of heteroduplexes formed during
PCR if the sample is heterozygous for a particular mutation. This feature is not shared with other
dyes traditionally used in real-time PCR, such as SYBR Green or ethidium bromide.

| LCGreen Plus +| SYBR® Greenl
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Chapter 2: Hi-Res Mutation Scanning

Derivative melting curves illustrate detection of heteroduplexes in the heterozygous mutant using
LCGreen Plus which are not detected using SYBR Green |.

The power of Hi-Res Melting is augmented by analytical software that allows visual inspection
of melting curve data to identify changes in the shape of the curve, indicating the presence of

sequence variances in the PCR product.

Step 1. The first step in the analysis is to normalize the raw melting data (wild type samples
are shown in black; and samples with SNP alleles are shown in other colors). In some
cases, samples with homozygous SNPs may be distinguished from the wild type by shifts in

melting temperature.
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Step 2. The next step is to temperature shift the curves at the point where the entire double-
stranded DNA is completely denatured. Now, samples with heterozygous SNPs can be eas-
ily distinguished from the wild type by the shift in the shape of their melting curves, which
often cluster into distinct groups according to genotype.

Step 2. Temperature Shifted Step 3. Difference Plot
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Step 3. The final step is to further analyze the shape differences by subtracting the curves from
a reference curve, thus generating a Difference Plot, which helps cluster samples automati-

cally into groups using the Call-IT software.
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Hi-Res Melting can identify sequence variants in an amplicon, but it is generally recommended that
the variants are confirmed by sequencing. The LCGreen Plus dye that is added to the PCR mixture
is compatible with traditional sequencing methods and will not damage the post-PCR product.

If an amplicon is known to contain a common polymorphism, the presence of the common
SNP can be ruled out by second-tier testing with an unlabeled probe instead of sequencing.
The LightScanner optics are designed to be compatible with Idaho Technology’s SimpleProbes
and a genotyping module in the software allows the user to perform scanning and probe based
genotyping on the same platform.

For more information on the LightScanner and its applications please visit our web site at
www.idahotech.com.
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Chapter 3: Preparing a LightScanner Experiment

Before you begin a LightScanner experiment, you must amplify your sample DNA using PCR in
the presence of LCGreen Plus. After DNA amplification, you can immediately place the sample
plate into the LightScanner and begin Hi-Res Melting. No post-PCR sample manipulation is
required.

To generate the best results, it is essential to optimize the DNA amplification such that nonspe-
cific targets are minimized (or eliminated altogether) and that the desired product is robust.

This section provides step-by-step instructions for preparing a plate for a combined PCR and
LightScanner run. Plate specifications are different depending on whether you are using a 96-
or 384-well PCR plate. For information about using the LightScanner software to program the
LightScanner instrument and start the run, see Chapter 4, Running a LightScanner Experiment.

General Considerations and Tools Required for Assay Development

Modern laboratories are equipped to generate and optimize PCR products for application to Hi-Res
Melting. To successfully execute Hi-Res Melting assays, the following are necessary: 1) Laboratory-
hardware, 2) Software, 3) Reagents, 4) Sample preparation, 5) Qil overlay, and 6) PCR optimiza-
tion. Each of these issues is first considered separately followed by how they act in concert to
develop a gene-scanning assay.

Hardware
* LightScanner Instrument

* Thermal block PCR instrument (an instrument with temperature gradient function is
beneficial)

» Plastic disposables (see recommendations in Appendix B)
*  Gel electrophoresis system

» Ultraviolet-visible (UV/VIS) spectrophotometer
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»  Standard laboratory equipment (pipettes, centrifuge, consumables, etc.)
+ LightCycler® (optional)
* Hi-Res Melting Instrument, HR-1™ (optional, Part No. HR01-ASY-0001)

Oligonucleotide Design Software

Oligonucleotide design software is an indispensable tool for the modern molecular biologist; how-
ever, software is only a tool that suggests appropriate primer design. The most powerful capability
of software is identifying undesired base pairing interactions such as hairpins, homodimeric inter-
actions, heterodimeric interactions, and primer to amplicon interactions. Unfortunately irrelevant
interactions are often identified that will never form in PCR and exist only in computer simulation.
There are numerous primer design software packages, each having characteristic strengths and
weaknesses. We recommend using the LightScanner Primer Design Software for designing prim-
ers to be used with the LightScanner System.

Reagents

Use of the LightScanner Master Mix will drastically reduce the amount of time required to opti-
mize primer sets. Use of LCGreen Plus in combination with other commercially available PCR
buffers is possible but may require additional optimization. Please see Appendix E, Additional
Optimization Considerations, for more details.

Sample Preparation

Hi-Res Melting compares profiles from independent PCR reactions; therefore, minimizing reac-
tion-to-reaction variability is pivotal. Samples to be analyzed using Hi-Res Melting should be
extracted using a common extraction platform. This eliminates the subtle differences in the
reagent components between the final elution buffers from multiple extraction platforms.

Ten to 20 ng of template genomic DNA in a 10-pL reaction is recommended.

Oil Overlay

To avoid evaporation of the samples during Hi-Res Melting an overlay is necessary. The recom-
mended overlay is common mineral oil. For a 10-uL PCR reaction, a 15-20 pL mineral oil overlay
is required.

PCR Optimization

Specific amplification product, undesired amplification product(s), and dimer product all bind
LCGreen Plus with equal affinity and contribute to overall fluorescence and the melting profile.
To optimize the amplification determine the best concentration for individual reaction components
and the best thermal cycling parameters. The steps below focus upon developing a new PCR
reaction; however, these may be used to adapt established PCR reactions to Hi-Res Melting.

9 Note: In thermal cycling, the annealing temperature influences specificity and robustness of
amplification the most. Gradient PCR is useful for quickly optimizing PCR cycling conditions.
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Step 1: Set up the PCR reaction using the LightScanner Master Mix. The following reaction vol-
umes are recommended in a final reaction volume of 10 pL.

Component Volume Final Concentration
LightScanner Master Mix 4 uL 1X
Forward Primer 1L 0.25 uM
Reverse Primer 1L 0.25 uM
Water 3L NA
DNA 1L 10-20 ng

Step 2: Program a gradient-capable thermal block with the following protocol to determine opti-
mum annealing temperatures (for primers with estimated Tm’s of 60-64 °C).

Cycles Temperature Time
Hold 95 °C 2 min.
94 °C 30 sec.
45 cycles 60-72 °C 30 sec.
1 cycle 94 °C 30 sec.
(heteroduplex formation) 25 °C hold until plate is
removed

Step 3: Run the samples on the LightScanner Instrument using the following parameters:

Start Temperature 70 °C
End Temperature 96 °C
Hold Temperature 67 °C
Exposure Auto

Step 4: Load 7 pL of each sample onto a 2—4% agarose gel for analysis.

The combination of the PCR information and the resulting melt data provide a method for deter-
mining the optimal PCR conditions.

Correlate the melt profiles of the gradient experiment plate with the gel results to choose the best
candidate PCR condition. Use the following guidelines to interpret the data. See the sample gel
image and melt profile below.

1. Identify the highest annealing temperature where the desired product is created (this will
likely be a less robust band but should be the only visible band in that sample).

2. Identify the lowest annealing temperature where specificity of the primers is maintained (this
should be one of the most robust bands on the gel).

3. The annealing temperatures in between these temperatures (highest and lowest) are all can-
didate PCR conditions for the primer set.
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4. Analyze the melt profiles of the candidate PCR conditions identified from the gel.

: The condition that has the greatest amount of initial fluorescence combined with the greatest
amount of fluorescence change from the beginning of the melt to baseline is the best candi-
date.

In the following example, an annealing temperature of 70.1 °C is optimal.
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Using several (at least 10) different DNA samples, all from a common DNA prep, run each sam-
ple in duplicate using the best candidate PCR protocol based on the gradient experiment.

Melting curve analysis on the LightScanner will usually be sufficient for determining the success
of the duplicate plate experiment.

* All samples should amplify robustly
— Auto exposure should be < 80ms
— Initial fluorescence in all samples should be greater than 800

* All samples should have “clean” melts

— No small melts at lower than expected temperatures based on the melting results of the
gradient experiment plate

*  Duplicate samples should group together

* All samples should group easily into a common group
— Unless there are common variants in the fragment, or samples with known variants were
run on the duplicate plate experiment
— If samples with known variants were run, these samples (and their duplicates) should
group separately from the common, WT group.

» If excessive manipulation of the normalization cursors or temperature shifting threshold is
necessary to get the sample curves to group, further optimization may be beneficial.
— MgCl titration (2.0-3 mM final)
— Primer concentration (0.15-0.4 pM final),
— DMSO (5-10% final) or TMSO (0.5-1% final)

If further optimization efforts are not successful on a new annealing temperature gradient experi-
ment, the primers may require redesign.
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Method Background

Genotyping with unlabeled probes is an homogeneous, end-point assay. The probe is included in
the PCR mix but is not consumed during amplification. Genotyping is accomplished by monitor-
ing the melting of probe-target duplexes post-PCR. Key to the method is the use of one primer in
excess, which leads to the overproduction of the target strand.

Assay Design

Use the following guidelines when designing an unlabeled probe genotyping assay:

* ldentify the location of the SNP and determine all the variants present in the region of the
amplicon to be sure that you do not place your primers across any polymorphisms.

* Design primers with a Tm of 60-65 °C.

» Design the probe with a Tm of 65-70 °C (we recommend designing the probe an average
of 5 °C greater than the primer Tm).

» Design probe length to be between 20 and 35 bases.

» Design the probe with the mutation site located towards the middle of the probe to maximize
the instability with the mismatched variant.

« To prevent extension of the probe, a C3 block is recommended for the 3' end. (3' C3 blocking
is available from most oligonucleotide synthesis vendors; specify when ordering the probe).

*  Check primers and probes using commercial design software to minimize complementarity,
hairpins, etc. Check oligos using the Basic Local Alignment Search Tool (BLAST) to ensure
specificity.

Experimental Set Up
Reaction Chemistry: 10 yL per reaction volume

Reaction Component Volume (uL) Final Concentration
LightScanner Master Mix 4 1X
Forward Primer 1 0.1 pM*
Reverse Primer 1 0.5 uM
Unlabeled Probe 2 0.5 uM
DNA 2 10 ng

*Note the 5:1 asymmetry in primer concentration, favoring formation of the probe-target duplex.
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Genotyping Results—Example

<32>

Cycling Conditions

Initial Denaturation 94 °C 30 sec. 1 cycle
Amplification 94 °C 30 sec. 55 cycles*
64 °C 30 sec.
72 °C 30 sec.

*55 cycles of PCR is recommended to allow, on average, 10 cycles of amplification beyond the plateau
phase of the PCR reaction to ensure an abundant quantity of probe/target complex.

A single probe recognizes all three genotypes. In this example, the probe is designed to match
the G allele. Probe-target hybrids to the G allele have a higher melting temperature because they
are perfectly paired. The C allele hybrids have a lower melting temperature due to the probe-
target mismatch. The heterozygous samples (shown below in red) demonstrate melting profiles
resembling the combination of homozygous samples.
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For more information on PCR optimization, optimizing internal reaction chemistry, developing a
panel of PCR assays to function together in Hi-Res Melting, and secondary uses of PCR product
previously employed for Hi-Res Melting, see Appendix E, Additional Optimization Considerations.

LightScanner Instrument

System Manual Rev 04



Chapter 4: Running a LightScanner Experiment

The LightScanner software controls the LightScanner instrument based on information you pro-
vide, such as the starting and ending instrument temperatures.

This chapter explains the preparations you must make before running the experiment, then
describes the experiment steps in detail.

1. Prepare a master mix containing all the reaction reagents except the DNA/RNA template in a
1.5 ml or 0.5 ml reaction tube.

2. Pipette oil overlay into each well.

3. Pipette the reagent mix into the wells on the PCR plate. Robotic or parallel (8- or 12-tip)
pipetting is helpful when processing large numbers of samples.

4. Add the DNA template to each well.
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5. Seal the plate with adhesive plate film.

6. Centrifuge plate at 1000 rpm for 1 min. Check the wells for bubbles and repeat if necessary.

9 Note: Centrifuge only with appropriate plate adapters. Do not exceed a centrifugation speed
of 3000 rpm.
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7. Perform PCR amplification on a thermal block cycler.

9 Note: Thermal block protocol should end with a final denaturation step (hold for 30 sec. at
94 °C), followed by rapid cooling to a final hold at 20 °C.

8. Repeat centrifuge step.
9. Remove adhesive film from plate if not using optically clear tape.

Running an Experiment

* Turn on the LightScanner instrument and computer.
» Double-click the LightScanner icon on the computer desktop to start the software.

& WARNING: Do not turn the instrument off while the software is running. If you turn the instru-
ment off, you must close the software, restart the instrument and the software, then restart any
experiment that was in progress.

A message bar in the “Run Status” box displays the current status of the instrument (“Ready”).
During the experiment run, the message bar displays the current temperature and estimated time
to completion. The message bar also displays instructions for various tasks, as necessary.

1. Select New Run from the file menu or press the Run button at the top of the screen.

2 | jghtScanner Software with Call-IT 2.0

File Analysis Tools Help

4 | jghtScanner Software with Call-IT 2.0
5N Analysis Tools  Help

Mews Run...
Qpen...
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Setting the Starting and Ending Temperatures

When you start an experiment, you must specify the starting and ending temperatures for the
melt. The default temperature parameters are 45 °C and 90 °C. If you are confident of the ampli-
con’s melting temperature you can adjust these temperatures accordingly.

1& CAUTION: If you set temperature parameters too close to the melting temperature range of
the amplicon you may not detect melting transitions associated with unknown polymorphisms. Be
conservative with your initial estimates. Enter a temperature range wide enough to encompass
any melting temperatures associated with the formation of heteroduplexes.

To Set the Temperatures

1. In the Start Temp and End Temp boxes, select the starting and ending temperatures for the
melt.

2. The Hold Temp box will automatically be set to 3 °C below the start temperature.

— Fun Contrals

Start Temp " Hald Temp 74
End Temp 95 Exposure [ms) At

Bar Code | Fine Tune Map | Start Run | Shop Run |

3. Leave Auto selected in the Exposure box. (For information about manually setting the
exposure, see “Manually Determining Exposure Time,” later in this chapter.)

4. If you use a bar code, click Bar Code once, then hold the side of the plate with the bar code
sticker in front of the bar code reader on the LightScanner (bar code reader only available on
384-well LightScanner).

The red bar code reader light turns on. When the bar code is scanned, the instrument issues
a beep, then the light turns off. The bar code is displayed in the message bar.

@ Note: If you make a mistake, for example scanning the wrong bar code, you must start a new
experiment before you can rescan the bar code.

Loading a Plate and Starting the Run

& CAUTION: Use only white PCR plates in the LightScanner instrument (see Appendix B).

1. When using a 96-well LightScanner with a half-skirt plate, set the plate into the provided
adapter before inserting the plate into the machine.
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2. Load plate into LightScanner, inserting the notched edges first. Push the plate fully into the
LightScanner. When the machine detects the plate, it issues a beep and automatically closes
the door.

3. Click Start Run

If a bar code was scanned before inserting the plate, the software appends the name of the
machine and the current date and time to the bar code. The experiment files will have the
following name format:

barcode _machine_date_time.extension

5. If a bar code was not scanned, a file selection dialog will be displayed. Select an experi-
ment name used to save the collected data and press Save.
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The software appends the name of the machine and the current date and time to the experi-
ment name. The experiment files will have the following name format:

alphanumeric-name_machine_date_time.extension

The software creates a folder with the same name as the experiment and stores all experi-
ment files in the folder. The default location for the folder is C:\LightScanner Data\. (If you
enter an experiment name, instead of a bar code, you can choose to save the experiment
data in another location.)

@ Note: If you give the experiment the same name as a previous experiment, the associ-
ated files are saved in the previously created folder. In this case, the unique identifier for the file
names is the date and time stamp.

@ Note: If the current temperature of the instrument is greater than the designated starting tem-
perature, you are prompted to turn on the instrument fan. Click Fan On. The tray is ejected. The
message bar displays temperature readings as they decrease. When the temperature reaches

3° C below the designated starting temperature, the message bar says “Ready.” Rescan the bar
code (if using), reinsert the plate, and click Start Run to restart the experiment.

During the Run

<38>

Once the run starts, the LightScanner determines the proper exposure, fine-tunes the well map,
and then starts collecting the scanning data. Messages in the message bar describe the instru-
ment’s progress.

When the block reaches the starting temperature, the message bar displays the current instru-

ment temperature and estimated time to completion. The Run Status box displays the run name,
the run parameters, and the message “Started.”
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* LightScanner Seftware with Call-IT 2.0; C:WightScannerataWelData\Testheli6) Testbe16_L SHetald_2007_10_75_16_31_13.mat
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As data is collected, the software displays a chart of fluorescence versus temperature.

During the run, select the wells to be displayed using the buttons in the Sample Selection grid.
If no samples are selected, the software displays the four samples in the upper left quadrant of
the sample selection grid. You can display all the samples on the plate by clicking on the blank
square at the upper-left corner of the grid.
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If you must end a run before the experiment is finished, click Stop Run. The software saves
all data collected to this point. The Run Status box displays the temperature when the run was
stopped.

When the experiment is finished, the instrument turns off the heat block, ejects the plate, turns on
the cool-down fan and cools down to the hold temperature. The data is then loaded for analysis.
The message bar displays temperature readings as the readings decrease during cool-down.

After the Run

You can access and analyze your data while the instrument is cooling down by moving directly to
the Home page or by clicking one of the analysis buttons across the top.

1. To analyze the data, select either the Scanning or Genotyping button in the Analysis box.

2. To start another run, wait for the LightScanner to cool and select New Run from the File
menu or run from the Home page.

ANAlYSIS powerea sy canr~

Genotyping
Small Amplicon
Unlabeled Probes

Labeled Probes
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Hi-Res Melting performs two types of data analyses: mutation scanning and genotyping. The
analyses functions are accessed via the Home page.

P inri

LightScanner

Instrument & Analysis Software

By e

designed by ldaho Technology Inc.

Both types of analyses have the following common functions, each of which will be discussed in
this chapter:

* Analysis subset definition
*  Sample name definition

« Editing groups

* Importing analysis settings
*  Working with reports

«  Defining colors

*  Working with graphics
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<42>

Genotyping using also includes the following three options:

1. High resolution melting of very small amplicons
2. High resolution melting of unlabeled probes (LunaProbes™)
3. Melting of fluorescent probes (HybProbe® or SimpleProbe)

All three methods have advantages depending on the application. Data analysis on the
LightScanner is customized to the method used, so it is important to select the correct analysis
method for your application. For more information on choosing between the different genotyping
methods visit www.idahotech.com.

The LightScanner Software window consists of three primary menus to help you select and save
analysis screens: the Menu Bar, Index Bar, and Analysis Subtabs.

Menu Bar: This bar contains menus to access and perform software functions.

Index Bar: This bar contains buttons used for common tasks in the current window, including
subset definition, the sample editor, and the report screens. The button selections vary slightly
depending on the analysis window that is currently displayed. The Index bar will display the anal-
ysis option selected from the home page, i.e., Scanning or Genotyping.

Analysis Subtabs: These subtabs are arranged sequentially to lead you through all of the steps
required to complete an analysis.
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Subsets can be defined by selecting the Subsets index tab at the top of the screen.

i, LightScanner Software with Call-IT 2.0: L:fJanafkurtshortamp
File Analvsis Tools Help

Home Subszets Samplesz Scanning Report

The term Subset is used to define individual amplicons that are arrayed on a single plate such
that samples from a PCR fragment will be grouped and analyzed together. This is useful if you
use one section of a PCR plate for one amplicon and another section of the same plate for a dif-
ferent amplicon. If all the samples on a plate are derived from the same amplicon, there is no
need to define any subsets.

If you have divided your plate up between multiple amplicons, use the Subset screen to tell the
software the locations of the samples that belong to the same amplicon set. You can define your
own analysis subsets or import subset definitions that are provided with the software. The sub-
sets provided with the software are commonly used sets, including row-wise subsets, column-
wise subsets, quartered subsets, and quadrant subsets. The quadrant subsets divide 2 x 2
blocks of the plate into a checkerboard pattern of northeast, southeast, southwest, and northwest
samples.

Defining a Subset

Select the Subsets index tab at the top of the screen.

2. To add a subset, select New Subset, then enter a subset name in the box below the Sample
Selection grid. Default names are “Analysis Set 17, “Analysis Set 2” and so on.

3. To define the samples contained within a subset, click the samples in the sample selection
grid or right-click and box the individual sample lines in the chart (the selected sample lines
turn black).

Q)
Note: To restore the sample colors in the chart, right-click anywhere on the chart and select
Deselect All. To zoom in on the chart, left-click and drag across the area to be magnified. To
restore the original magnification left-click anywhere on the graph.

4. Once the samples belonging to a subset have been selected, click Add Marked to Subset to
complete the definition of the subset.

Repeat Steps 3 and 4 until you have defined all the subsets.

Select the Export Subsets button on the left hand side of the screen to save the subsets.
The subsets will be saved as a *.sbs file.

7. Apply the saved subsets to a new data set by using the Import Subsets button.

To view samples in a subset, select a subset from the Select Subset to Edit box. In the sample
grid:

* Blue boxes mark the samples in the selected subset.
*  White boxes mark the samples in other subsets.
*  Gray boxes mark sample locations that are not assigned to subsets.
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You can save time by importing frequently used subset configurations. Also, if you always lay
your plate out in the same configuration you can save a custom subset configuration for re-use.
The saved subset settings can then be imported into any new experiment.

Edit Subszetz

Mew Subzet Copy Report Subsets

Impaort Subzets Esport Subzets

Select the subset name from the Select Subset to Edit box.

1. To add samples to the subset, select the samples using the sample grid or right-click on the
curve in the graph, then select Add Marked to Subset.

2. To delete samples from the subset, select blue boxes in the grid or right-click on the curve in
the graph, then select Delete Marked from Samples.

3. To edit the name of the subset, type the new name in the Edit Subset Name box.
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Deleting a Subset

1. Select the subset name from the Select Subset to Edit box.
2. Select Delete Subset.

— Edit Subzet Samples
Select Subset o Edit Analpgiz Set 1 :_J
Add Marked to Subset Delete Marked fram Subzet
Delete Selected Subzet Identify S ample

In the LightScanner software, sample names are associated with a data set after the melting

is completed. Every time an experimental file is opened, the user is able to access the Subset
definition module and the Sample annotation module from the index tab at the top of the screen.
Once subsets have been defined, you have the opportunity to add sample name information

to your experiment. The sample editor can be accessed from the Samples tab at the top of the
screen. If you have defined analysis subsets, you can display the samples by subset.

L LightScanner Software with Call-IT 2.0: L:/Janafkurtshortam

File Anakvsis Tools Help

| Home Subsets Samples Sanning Report

)
Note: Sample names can be imported in from a previously analyzed *.mat file, from a saved
text file, or entered in de novo in the Samples tab.

Manually Entering in Sample Names for an Experiment

1. Open the Samples tab and type in the names corresponding to the sample position. If you
have defined analysis subsets you can display the samples by subset.
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The sample selection grid is active in this tab and can be used to control the display.
Activating a sample using the sample selection grid will display the melting data as well as
the sample name in the adjacent sample editor table. Selecting the Tabulate Selected option
will limit the table display to the samples selected in the grid, whereas choosing the Tabulate
All option will display a list of all the sample names.

Defining a Sample as a Standard

<46 >

If you are using known reference standards in your melting analysis, you can define them in the
sample editor.

To select a sample as a standard:

1.
2.

Mark the check box next to the sample name in the Std column.

The Group field will now become active and you can enter the group (or cluster) name that
you wish to assign to this standard (example: Wild Type).

The software will automatically select the Use Internal Standards grouping option in the sub-
sequent analysis.

The assigned Group name will be used in the final grouping analysis display.

Note: Samples assigned to the same group are expected to produce similar melting profiles

to be analyzed correctly.

Duplicate samples with the same name should not be assigned different group names or a
software error will result. Multiple samples that are assigned as standards with the same group
name, but upon completion of the analysis are found to not fall into the same group, will result in
a software error as well. If this occurs, return to the sample editor tab and de-select the outlier as
a standard, and then re-analyze the edited data.
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Exporting Sample Names to a *.smp File

If a common set of samples are used for several experiments you only have to enter the sample
name information once and export them for use with subsequent experiments.

1. Go to the File menu and choose Export > Export Sample Names or select the Export but-
ton in the Sample Editor tab.

2. Name and save this exported file as a *.smp.

Importing Sample Names from a *.smp File

To associate exported sample names with a new experiment:
1. Open the new experiment

2. Go to the File menu and choose Import > Import Sample Names or select the Import but-
ton in the Sample Editor tab.

3. Select the file with the desired sample names. The sample name fields will automatically be
populated with the imported information.

Importing Sample Names from an External Text File

Create a sample sheet template in a spreadsheet or in a tab delimited text file in the following
order: Row, Column, Sample name, Standard, Group.

A 1 PID 12345 Standard WT
B 1 PID 32792
C 1 PID 63651

@ Note: Do not use headers in the spreadsheet. If Standards are not used in the experiment,
leave the last column blank. If standards are designated in the sample sheet the software will
automatically select the Use Internal Standards option as the analysis method for grouping.

Importing a sample sheet is useful when interfacing with Laboratory Information Management
System (LIMS) but can also save time by allowing a user to set up a sample sheet at their own
convenience, or use a standard template for multiple experiments.

The final common step in all LightScanner analysis modules is the grouping of samples by melt-
ing profile. Groups are assigned a color, and all samples within a group are the same color. This
section describes some of the Group editing features available in the software.

In some cases you may wish to manually overwrite the calls made by the software, either to
assign an unknown sample into a particular group or to reassign a call. There are two ways to
edit the grouping calls:

* You can edit an entire group by reassigning it as the Wild Type group, deleting it completely,
or adding a new group into which you will manually assign samples.

*  You can edit an individual sample, or a group of samples, by using the Edit Call functions.
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r— Edit Groups
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Editing a Group

Select the group from the pull-down menu in the Edit Groups field.

2. Choose to assign the group as the Wild Type group by selecting the button next to the group
name.

3. Alternatively, delete the entire group. Note that once a group is deleted it cannot be restored
without going through the analysis again.

4. Add a group. This button will add a group to the data set, giving it a letter name. This new
group will not be populated with any samples until you do so by using the Edit Call functions.

Editing a Call

1. Select the sample(s) you would like to edit by clicking the sample well or right-clicking directly
on the curve in the chart. You can select multiple samples by using right-click + box. Selected
samples will appear as black lines on the screen.

2. In the New Call box, select the group that will contain the sample(s). Select Apply Change.

The sample(s) will now be assigned to the chosen group. The sample name will be marked
with an asterisk in the report table indicating that a manual change has been made to the
grouping assignment.

Editing the Baseline

Choose the Select Baseline button in the grouping window.
The name of the button will change to Finish Selection.

Select a single sample, a set of samples, or an entire group (pick the colored box next to the
group name) in the sample selection grid and select Finish Selection.

The chosen samples will be used to calculate the baseline, and the graphical display will
change.

Renaming a Group

Default group names are simple one letter names. To rename a group, select the Group Names
tab and edit the name directly in the box adjacent to the group color.

<48 >
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On occasion it is helpful to be able to copy the graphs and figures generated from the
LightScanner software into other documents. If you have a figure that you would like to copy to
the clipboard, simply right-click on the figure and select Copy. You can now paste the figure into
a word processing program, slide program, or any other application. This feature is active for all
the graphs (melting curves, melting peaks, etc.) in all the analysis modules. It is not active on the
sample selection grids displayed next to the graphs.
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It is possible to analyze a new experiment using the analysis settings from a previous experiment.
In this case the subsets, the normalization cursor placements, the curve shift setting, the grouping
method, and the grouping sensitivity from the reference file will all be maintained in the analysis
of the new data.

The following steps are required to import analysis settings from a *.mat file:

*  Open the new experiment file using the correct analysis module (Scanning or Genotyping).
Analysis settings can only be applied to files that use the same analysis module (i.e., scan-
ning file settings applied to scanning files only)

« Define any negatives in the Negative Filter tab.

* Go to the File menu and select Import > Import Scanning Analysis (or Import Genotype
Analysis)

* You will be taken to the Grouping tab where the analyzed data will be displayed. At this point
the analysis can be changed if required.

)
Note: You must remember to define the negatives before importing the analysis settings.

Viewing Reports

To view a report

After you complete your analysis, click the Reports tab at the top of the screen. The Report
Screen displays:

A summary graph for the selected subset (if applicable) or the complete data set if no subsets
were used in the analysis. If there is more than one subset, select the subset name from the
Subset box in the tool bar to display the correct data.

« All of the analysis settings and parameters, captured in the display window at the upper left.

» Aset of arrows at the top of the screen allow you to scroll through the detailed data reporting
features. Click the buttons labeled First, Back, Next, and Last to view all the pages.

« If you have not modified the report subsets, they will be the same as the analysis subsets.
To print each page of a report, click Print in the upper right corner of the window.

To copy a graph, right click on the graph to bring up the menu of options for copying graphics.

Preparing Tailored Reports

<50>

A tailored report can be prepared for selected samples from a plate. If you have divided up your
plate into different Analysis subsets you are not restricted to reporting the data by subset. You
can prepare a tailored report (Distinct Subset Report) that includes samples chosen from any-
where on the plate.
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For example, each column in a PCR plate might be used to analyze a different exon, while each
row in the plate might represent a different patient sample. You can choose to report the data for
a single row, representing the results from each exon for a single patient sample.

To prepare a tailored report

1. Move to the Report tab after completing the data analysis.
2. Select the Subset button at the top right of the screen.

Subszets Print Cloze Repart

3. Create a report subset by selecting New Subset button, highlighting the samples you want to
report together and then selecting Add marked to Subset.

4. As with the Analysis subsets, you can give the subset a custom name, but the default will say
Report Set 1.

5. Once you define all the required Report subsets, move back to the Report window by using
the button at the top of the screen.

6. Your data will now be displayed as Report subsets.

If you copy the analysis subsets into the report subsets using the Copy Analysis Subsets button,
they will again remain the same as the analysis subsets.

When you define report sets, you can also specify whether the report contains the detailed

sample data and the detailed sample graphs by selecting or deselecting the boxes in the Report
Features section.

You can customize the colors used in the LightScanner charts and displays by going to the
Define Colors function.

1. From the Tools select Define Colors

2. To change the chart colors, select from the following:

Cyclic Periodically uses 25 colors

By row Color every row the same

By column Color every column the same

By group Color samples by genotype group

To define a group button color, press a group button at below the Sample Selection Grid and
choose a custom color.
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— Define Colors
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To define color maps for the Tm/Area maps, select from the options Define Color Map box.

Define Colotdap

Select default Tm colors | Gray -
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Mutation scanning uses Hi-Res Melting and LCGreen Plus to detect the presence of sequence
variation in a fragment of amplified DNA. The technique is especially useful in identifying
heteroduplexes, which traditionally have required an additional separation step for identification.
The Hi-Res Melting profile reveals heterozygous single-base changes in 2—-5 min. with a sensitiv-
ity and specificity superior to nonhomogenous techniques such as denaturing high performance
liquid chromatography (DHPLC) and temperature gradient capillary electrophoresis (TGCE). In
addition to identifying anonymous heterozygous variants, you can also identify specific mutations.
In this case, scanning and genotyping can be often combined into one simple melting analysis.

To use this analysis method after completing a run, return to the Home tab and select Scanning.

There are four steps that must be followed when analyzing Hi-Res Melting data. The steps are
arranged sequentially by tabs on the software and in each case the software will present you with
best-guess default settings that can be modified if necessary.

The analysis sequence is as follows:

Step 1. Negative Filter: Known negatives and failed PCR reactions should be excluded before
the analysis to prevent false positive results. You can identify known negatives manually or allow
the software to determine the negatives automatically

Step 2. Normalize: The melting curves are normalized to have the same beginning and ending
fluorescence.

Step 3. Curve Shift: All the melting curves are brought together at a single point at the comple-
tion of denaturation to compensate for slight temperature variation across the plate and increase
the accuracy of the results.

Step 4. Grouping: The software automatically clusters samples into groups with similar melting
profiles.
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Start the software, then select Scanning under the Analysis section of the home page.

2. Select a *.mat file to analyze newly collected data or inspect or re-analyze previously ana-
lyzed data, then select Open.

3. If you open a file that has not been previously analyzed, you will be taken directly to the
Subset Selection screen. If you open an analyzed file, you will be taken to the Negative Filter
selection screen.

Choose a file

Look jr: | (2 010607 PAH HLS2 LA30-32 Homo Scan ﬂ L I‘j‘ B

{{ 2 010607 PAH HLS3 LA30-32 Homa Scan_S0960001_2007_01_05_10_01_35.mlt
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If you use the file menu to open a data set, the software will prompt you to select the appropriate
analysis method.

Select the type of analysis you would like to do:

Analysis powered by Call-IT™

Small Amplicon

Unlabeled Probes

- Labeled Probes

Once subsets have been defined, move to the Scanning tab at the top of the screen to continue
the analysis. If subsets have been defined you must analyze each subset independently. A pull-
down menu at the top of the screen will display the data as the selected subset. The Negative
Filter is used to identify any samples that were included on the plate as negative controls and
any failed PCR reactions. It is important to identify negatives before the next analysis step of data
normalization to avoid the possibility of generating false positive data.
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To identify negative samples manually:
1. In the Negative Filter tab, select Negative from the New Call pull-down menu.

2. Select samples by using right-click + drag to box the selection, or click the negative sample
wells in the sample grid.

3. Select Apply Change.
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4. To auto-select negative samples, select Auto-Call from the New Call pull-down menu and
select Apply Change.

Data acquired during Hi-Res Melting will vary in the magnitude of the fluorescence for each sam-
ple because of differences in the starting template or optics. Viewed this way it is often difficult to
see any consistent differences between genotypes. Therefore the first step in the analysis pro-
cess is to normalize the data. Two regions are selected one before and one after the major transi-
tion that will define 100% fluorescence and a 0% baseline. These regions are defined by cursors
that are automatically set by the software but can be adjusted by the user if required.

To normalize the data:
1. Move to the Normalize tab.

2. The software automatically places the temperature cursors in a suitable region for normaliza-
tion and displays the normalized data in the lower chart.

@ Note: The user has the option of choosing between linear or exponential background correc-
tion. Choose Linear (default) for single melting transitions and choose Exponential for complex,
multi-domain melting transitions.
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<56>

3. Visually confirm that the Lower Min and Lower Max temperature cursors are placed in a
region of the curves, where the background fluorescence is dropping in a consistent way over
all the samples, but before any temperature transitions have occurred.

4. |deally the melting transitions should be flanked by 1-3 degrees of flat, normalized baseline
regions.

5. If the cursors are located at the outer edges of the graph, pull them in towards the melting
transition by dragging the cursors with your mouse or entering numerical values in the tem-
perature boxes above the sliders.
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6. You can toggle between displaying normalized melting curves, temperature shifted melting
curves, and difference curves using the pull-down menu in the lower graph.

The curve shift function is included in the data analysis to overcome the effect of absolute tem-
perature variation from position-to-position across the plate. Curve shifting is performed by select-
ing a percent fluorescence value close to the tail end of the melting curve where all the samples
are brought together. The default position chosen by the software is 5% (0.05) and is suitable for
almost all applications.

By moving to the tab, the software automatically applies the Curve Shift function to the data. The
upper graph shows you the original, normalized data, the lower graph shows the shifted data. In
this step, samples of identical sequence should now trace identical melting profiles, and distinct
clusters of profiles should become visible if variants are present in the data set.

In some cases homozygous variants can be visible more clearly before curve shifting. This is
because both types of homozygous samples have the same melting profile shapes but differ by
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absolute melting temperature. If this is the case with your sample set, it may be necessary to
move the curve shift level. Do this by dragging the line visible on the lower graph up or down
as necessary.

Be aware that eliminating the curve shift function introduces a higher level of variation to the data
and may compromise the clustering of variants in the sample set, therefore it is not recommended.
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To perform curve shifting:
1. Select the Curve Shift tab.
2. Confirm that the normalized curves fall into distinct groups using the default setting of 0.05.

3. If the curves are not well resolved, adjust the shift level either by dragging the bar in the
Normalized Melting Curve graph or by entering a numerical value in the Shift Level box.
Remember the values in the box are expressed as percent maximum fluorescence.

4. You can toggle between displaying shifted melting curves and difference plots by using the
pull-down menu in the lower graph. The display you choose will be carried into the next tab.

The final step of the analysis is to separate the samples into groups based on the shapes of the
melting curves. In this tab the data is presented in two ways: a graph showing the melting curve
profiles and a subtractive difference plot of the fluorescence in comparison to single a reference
sample. The reference group is the one with the most numerous samples (the common group);
however, the reference sample set can be changed manually by the user, if a known reference is
included on the plate, by clicking on the Select Baseline button..
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Grouping Samples Based On Curve Shape

<58>

The default grouping method is the Common versus Variant method. Using this method, the
software selects the group with the largest number of samples and assigns it as the common
group; samples with melting profiles different from the common group are put into the variant
group. This method allows you to quickly select samples that are different from normal without
any type of further classification. Typically these samples are then selected for sequencing to
confirm the differences. If the variant group is comprised of several subgroups, select the Group
Variants button to further classify the variants.

A second option for grouping is Auto Group. In this setting, samples are grouped by curve shape
with no bias towards any one group. Up to 10 unique groups can be assigned to any one data
set, in addition to the negative group and the unknown group which are always included despite
the fact that they may not always be populated.

The third option is to group samples around known standards that are defined by the user, this
method is called Use Internal Standards. The internal standards are defined by the user in the
Sample Editor and automatically retrieved by the software. If duplicate standards are used, the
average of the standards is used as the reference.

If the Internal Standards grouping option was selected, but only a single reference sample is
used, all the samples that belong to the group containing the reference sample are grouped
together. All the remaining samples are assigned as Unknown (green). To further cluster the
unknown samples into individual groups, select the Group Unknowns button in the Grouping
box.
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1. Choose the Grouping Method
From the Standards selection list, select the type of standards (Grouping Method) to be used:

¢ Common versus Variant
*  Auto Group
e Use Internal Standards

2. Choose the sensitivity—select between Normal and High:
*  Normal—select Normal sensitivity for melting profiles with single transitions.
* High—select High sensitivity for melting profiles with two or more transitions.

* A data set should be analyzed on a Normal sensitivity value when the standard deviation
of the melt profiles of the common group is large. Conversely, when the standard devia-
tion of the Common group is small, i.e., the data within the group are tightly clustered,
you may need to use high sensitivity.

3. Adjust the sensitivity slider bar.

Depending on the quality of the data you may need to adjust the grouping calls. The
Sensitivity slider bar allows you to adjust the grouping sensitivity to a value that best fits your
data. The grouping calls will change in real time as you adjust the slider, but you must press
the compute groups button when you have found the desired setting to preserve the analysis.

* The default (normal) sensitivity setting is zero.

* To raise the number of groups, increase the value in the slider bar by moving the cursor
or typing in the desired value.

» To reduce the number of groups, decrease the value in the slider bar.

» For the most consistent results, set the sensitivity level such that an increase or
decrease of 0.3 does not change the results. This will ensure that the calculations are
performed in a robust sensitivity range.

4. Select Compute Groups to calculate the grouping.

Samples will be color coded by group and displayed as both Melting Curves and Difference
Curves. The groupings are displayed graphically as well as on the plate map for easy cross
reference. In some cases it is easier to see differences between groups on the Difference
plot rather than the Melting Curve plot.

The Difference Curve plots are computed as follows:

First the software selects the group with the most number of samples.

Then the standard of that group (marked with the letter S in the plate display) is used as
the reference genotype. The difference in fluorescence between the reference and all
other curves is plotted against Temperature.

@ Note: If the Common versus Variant method is selected, the group with the most number
of samples is called the common group, all other samples are defined as variants and dis-
played in red. To sort the variants based on curve shape, use the Group Variants button. This
analysis format is illustrated in the screen capture above.

5. Save the results by going to the File menu and choosing Save. This will generate a *.mat file

with the same name as the run. The *.mat file can be reopened at any time and will display
all the saved analysis parameters.
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Move to the Results tab to view the analysis in tabulated format. Data is displayed by Row, Col,
Name, and Grouping Call. If a sample has been manually reassigned to a group, it will be marked
by an asterisk to flag it for future reference. These results can be exported in tab-delimited format
(Excel compatible) by going to the File menu and choosing Export Scanning Results. A *.rst file
will then be generated that can be opened with Excel or another spreadsheet program.
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Small amplicon genotyping (SAG) is a simple yet powerful genotyping technique. No probes are
required, making this technique simple, rapid, and inexpensive. Small amplicon genotyping can
produce the same high accuracy results previously associated only with probe-based techniques.

How Does It Work?

High resolution melting is performed on small amplicons (50—100 bp) designed so that the prim-
ers lie immediately adjacent to the SNP of interest. For best results, choose appropriate primers
using LightScanner Primer Design Software.
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Because the length of the amplicon is so small, all 3 species (homozygote1, homozygote 2, and
heterozygote) usually have unique melting profiles that can be used to accurately genotype a
sample.

Sensitivity and Specificity

The sensitivity and specificity of small amplicon genotyping have been shown to be extremely
high, especially for Class | and Class Il SNPs: A>C, A>G, T>C or T>G (comprising 85% of human
SNPs).

Genotyping becomes more difficult when the SNP is a base neutral change (the bases switch
strands but the base pair remains the same), e.g., A>T, where the homozygous AA must be dif-
ferentiated from the homozygous TT. In this case the homozygous species have such subtle dif-
ferences in melting profiles that experimental variation can mask the difference between the two
alleles.

This limitation can be overcome by using a LightScanner High Sensitivity Genotyping Master Mix.
The signal provided by temperature calibrators included in the mix is used to correct for small
mechanical and chemical variations resulting in highly precise genotyping calls. In general, this
Master Mix need only be used for small amplicon genotyping of polymorphisms where the melting
temperature of homozygous alleles is expected to differ by less than 0.5 °C (Class Il and Class
IV SNPs).
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<62>

The LightScanner Small Amplicon data analysis module allows data analysis of data generated
with or without temperature calibrators. For simplicity, the workflow described is for experiments
that include calibrators; however, only a single step is omitted when analyzing data that does not
include calibrators.

Once subsets and sample names have been defined, move to the Genotyping index tab at the
top of the screen to continue the analysis. This will put you in the negative filter screen with all
the analysis sub-tabs displayed sequentially.

Step 1. Negative Filter: In this screen, known negatives and failed PCR reactions should be
excluded before the analysis to prevent false positive results. You can identify negatives manually
or allow the software to determine the negatives automatically.

Step 2. Calibration: In this screen, you have the option of calibrating your data to known tem-
perature calibrators included in the High Sensitivity Genotyping master mix. The location of the
calibrators is built into the software and can be selected using a pull down menu.

Step 3. Normalize: The region of the amplicon melting is bracketed by two cursors that can be

adjusted by the user. Data is normalized to have the same beginning and ending fluorescence.

Once the melting region is defined, the data can be viewed as melting peaks, melting curves, or
difference plots.

Step 4. Grouping: The software automatically clusters samples into groups with similar melting
profiles.

Move to the Report tab in the index bar to get a final report of your experimental analysis.

To open a file:

1. Start the software then select Small Amplicon under the Genotyping Analysis section of
the home page.

2. Select a *.mat file to analyze newly collected data or to inspect previously analyzed data,
then select Open.

3. You will be taken to the Negative Filter selection screen of the analysis window.

Alternatively, you can open a *.mlt file that contains the raw melt data, but you will need to
wait a few moments as the software performs some precalculations. After this, you will be
taken directly to the Subsets window.

Once subsets and sample names have been defined, move to the Genotyping index tab at the
top of the screen. If subsets have been defined, you must analyze each subset independently. A
pull-down menu at the top of the screen will display a list of subsets.

The Negative Filter is used to identify any samples that were included on the plate as negative

controls and any failed PCR reactions. It is important to identify negatives before the next analy-
sis step of data normalization to avoid the possibility of generating false positive data.
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To identify negative samples:
1. In the Negative Filter tab, select Negative from the New Call pull-down menu.

2. Select samples by using right-click + drag to box the selection, or click the negative sample
wells in the sample grid.

3. Select Apply Change.
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If you are using the High Sensitivity Genotyping Master Mix, you will need to include calibration

in your analysis. The internal temperature calibrators included in the master mix are designed to
melt at 60.5 °C (Low Cal-1) and 92 °C (High Cal-1). If you are not using calibrators in your experi-
ment, leave the default selections (none) for the settings and move to the next tab.
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To define calibrator melting peaks:
1. Select the subset you want to analyze.

2. In the Tm Calibration Settings box, choose the positions of the Low and High Tm calibrators.
If you are using the High Sensitivity master mix, choose Low Cal-1 in the Tm Cal-1 field, and
High Cal-1 in the Tm Cal-2 field.

3. Cursors will automatically be placed in the regions of the calibrator melts.

9 Note: The cursors need only lie within the region of the melts; they do not need to lie directly
on the melting peaks (see preceding figure). The software is designed to analyze each sample
individually, find the correct calibrator melting peaks and make the calibration adjustments auto-
matically.

Creating Custom Calibrators

<64 >

If you have oligonucleotide calibrators that you have designed yourself, you have the option of
either using the manual method for cursor placement, or creating a custom calibration probe
library and inputting the known melting temperatures of the custom calibrators.

Manually place calibrator cursors by choosing the Manual method from the Tm Calibration
Settings pull-down menu.

Create a custom calibrator probe library by going to the File menu and selecting Calibration
Probe Library. A dialog box will be brought up. Enter the name of the probe and the expect-
ed Tm in the box and select Add and Save to exit. This probe will now be added to the Tm
Calibration Settings pull-down menu.

<} Calibration Probe Library

Calibration Probes
w Cal-1. B 50
High Cal-1. 92.00
Dramin
Probe Name: | Custom cal low
Probe Tm: |62
|lpdate I Add Remove Save Cancel
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In this tab the primary amplicon melting peak is bracketed by two cursors. The upper graph dis-
plays the full range of fluorescence data for the run. The lower graph displays either the normal-
ized melting curves, normalized melting peaks, or difference curves.

The software will automatically place the cursors in the assumed region of interest; however,
these can be adjusted manually by dragging them with the mouse.
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Use the melting peaks view and the melting curves view in the lower graph to confirm the correct
placement of the cursors. In the shifted melting peaks view (upper graph) the cursors should be
placed as close to the borders of the true peak as possible.

In the normalized melting curves view (lower graph) the beginning and ending fluorescence of all
the samples should come together in a tight, flat bundle.
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The figure above illustrates poor cursor placement resulting in an upward drift
of the fluorescence at high temperatures.
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Once the normalization step is completed, move to the Grouping tab to complete the analysis.

The final step of the analysis is to compute the samples into groups based on the melting pro-
file of the small amplicon. In this tab, the data is presented in two graphs: the upper graph dis-

plays Normalized Melting Curves and the lower graph displays Normalized Melting Peaks, or
Normalized Difference Curves.
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1. To compute the melting data into genotypes, first choose the grouping method from the
Standards pull-down menu. The software offers two grouping options:

* Auto Group—In this setting, samples are grouped by curve shape with no bias towards
any one group. Up to 10 unique groups can be assigned to a data set.

* Use Internal Standards—In this setting, samples are grouped around known standards
defined by the user in the Sample Editor. If only a single reference sample is used, all the
samples that belong to the group containing the reference sample are grouped together.
All the remaining samples are assigned as Unknown. To further cluster the unknown
samples into individual groups, select the Group Unknowns button in the Settings box.

2. Choose the sensitivity. The software offers two sensitivity settings
*  Normal—Select Normal sensitivity for peaks that are separated by 3-5 °C.

» High—Select High sensitivity to distinguish between groups that are separated by less
than 3 °C.
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3. Adjust the Sensitivity Level. Depending on the quality of the data, you may need to adjust
the grouping calls. The sensitivity slider bar allows you to adjust the grouping sensitivity to
a value that best fits your data. The grouping call will change in real time as you adjust the
slider, but you must select the Compute Groups button when you have found the desired
setting to preserve that analysis. Finding the correct sensitivity is especially important when
optimizing a new genotyping experiment. Once the sensitivity is established for an assay you
should be able to use the same settings to analyze subsequent experiments.

*  The default (nhormal) sensitivity setting is zero.

» To increase the number of groups, moving the slider bar to the right or type in the
desired value.

» To reduce the number of groups, decrease the value in the slider bar.

» For the most consistent results between experiments, set the sensitivity level such that
an increase or decrease of 0.3 does not change the results. This will ensure that the
calculations are performed in a robust sensitivity range and can be used in subsequent
experiments.

Select the Compute Groups button to complete the analysis.

5. Samples will be color coded by group and displayed graphically as both Normalized Melting
Peaks and Normalized Difference Curves. The groupings are displayed by color both on the
graphs as well as the plate map for easy cross reference.

6. Save the results by going to the File menu and choosing the Save option.

Move to the Results tab to view the analysis in tabulated format. Data is displayed by Row, Col,
Name, and Grouping Call. If a sample has been manually reassigned to a group, it will be marked
by an asterisk to flag it for future reference. These results can be exported in tab-delimited format
(Excel compatible) by going to the File menu and choosing Export Scanning Results. A *.rst file
will then be generated that can be opened with Excel or another spreadsheet program.
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Genotyping with unlabeled is probes is achieved using the LCGreen Plus DNA binding dye in
conjunction with a 3’-blocked oligonucleotide probe. In genotyping with unlabeled probes, the
probe is included in the PCR mix, but is not consumed during amplification. Dissociation of the
probe from the target strand is reflected in a reduction in fluorescence at the melting temperature
of the probe. The key to this method is that one primer is used in excess, leading to the overpro-
duction of the target strand. The melting transitions that are observed with unlabeled probes are
quite small compared to the amplicon melts that are also observed at higher temperatures; there-
fore fluorescence background subtraction and normalization are critical parts of the analysis. The
method provides the same specificity as current methods without the cost.

There are four steps that must be followed when analyzing Unlabeled Probe genotyping data.
The steps are arranged sequentially in the analysis subtabs on the software, and at each step the
software will present you with best-guess default settings that can be modified if necessary.

The analysis sequence is as follows:

Step 1. Negative filter: Known negatives and failed PCR reactions should be excluded before
the analysis to prevent false positive results. You can identify known false positives manually or
allow the software to determine the negatives automatically

Step 2. Normalize: The melting curves are normalized to have the same beginning and ending
fluorescence, and curves are displayed as derivative melting peaks.

Step 3. Grouping: The software automatically clusters samples into groups with similar melting
profiles.

Step 4. Tm calling: The derivative melting peaks are used to calculate a Tm for each peak.
Heterozygous samples that have two melting peaks have two Tm values displayed per sample.
The difference between the two Tm values (ATm) is also calculated for these samples and can
be used as additional analysis criteria for confirming genotypes.

Move to the Report tab in the Index Bar to get a final report of your experimental analysis.
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To open a file:

1. Start the software then select Unlabeled Probe under the Genotyping Analysis section of
the home page.

2. Select a *.mat file to analyze newly collected data or to inspect previously analyzed data,
then select Open.

3. You will be taken to the Negative Filter selection screen of the analysis window.

Alternatively, you can open a *.mlt file that contains the raw melt data, but you will need to
wait a few moments as the software performs some precalculations. After this, you will be
taken directly to the Subsets window.

The Negative Filter is used to identify any samples that were included on the plate as negative
controls and any failed PCR reactions. It is important to identify negatives before the next analy-
sis step of data normalization to avoid the possibility of generating false positive data. If subsets
have been defined, you must analyze each subset independently. A pull-down menu at the top of
the screen will display the data is the selected subset.

To identify negative samples:
1. In the Negative Filter tab, select Negative from the New Call pull-down menu.

2. Select samples by using right-click + drag to box the selection, or click the appropriate sam-
ple wells in the sample grid.

3. Select Apply Change.
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To normalize the data for unlabeled probes:

Move to the Normalize tab.

2. The upper chart displays the full range of fluorescent data for the run. The software automati-
cally performs the background subtraction and places the temperature cursors in a suitable
region for normalization. Visually confirm that the Minimum and Maximum temperature cur-
sors bracket the region of the probe melt.
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3. The lower chart displays the normalized derivative melting peaks of the data.

Normalized Melting Peaks
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4. Toggle the lower graph between melting peaks and melting curves to confirm that the cursor
placement is correct. In the melting curves graph, you should observe a completely flat region
before and after the melting transition to get the best results.
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5. If the cursors are located at the outer edges of the graph, pull them in towards the melting
transition by dragging the cursors with your mouse or entering numerical values in the tem-
perature boxes above the sliders.

The next step of the analysis is to compute the samples into groups based on the melting profile
of the probe. In the Grouping tab, the data is presented in two graphs. The upper graph is directly
carried over from the previous screen and can be toggled between melting curves and melting
peaks. The lower graph displays melting peaks only. The upper graph always displays all the
samples in the Analysis. The lower graph displays user selected samples.
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1. To compute the melting data into genotypes, first choose the grouping method from the
Standards pull-down menu. The software offers two grouping options:

» Auto Group—In this setting, samples are grouped by melting temperature with no bias
towards any one group. Up to 10 unique groups can be assigned to a data set.

* Use Internal Standards—In this setting, samples are grouped around known standards
defined by the user in the sample editor. If only a single reference sample is used, all
of the samples that belong to the group containing the reference sample are grouped
together. All the remaining samples are assigned as Unknown. To further cluster the
unknown samples into individual groups, select Group Unknowns.

Megative Fi\teli Norma\ize; Grouping I Tm Callingi Hesultsi Group Namas! Sequencel

— Grouping

Standards: IAutD group 'i Sensitivity: !Normal 'i
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|dentify S ample |

— Edit Groups

Group: IWT - WildT ype Group | Delete Group Add Group |
— EditCallz

Marked zamples will be changed to the type selected below

New Call: !Auto Cal - Apply Change

Statuz
r Ready
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2. Choose the sensitivity. The software offers two sensitivity settings

* Normal—Select Normal sensitivity for peaks that are separated by 3-5 °C.

» High—Select High sensitivity to distinguish between groups that are separated by less

than 3 °C.
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In general, normal sensitivity should be used for peaks that are separated by 3-5 °C. The High
sensitivity setting may be needed for peaks that are less well separated (see example below)
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Normal Sensitivity Example

3. Adjust the sensitivity level.
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High Sensitivity Example

Depending on the quality of the data, you may need to adjust the grouping calls. The sensitiv-
ity slider bar allows you to adjust the grouping sensitivity to a value that best fits your data.
The grouping call will change in real time as you adjust the slider, but you must select the
Compute Groups button when you have found the desired setting to preserve that analy-
sis. Finding the correct sensitivity is especially important when optimizing a new genotyping
experiment. Once the sensitivity is established for an assay, you should be able to use the
same settings to analyze subsequent experiments.

*  The default (normal) sensitivity setting is zero.

* To increase the number of groups, move the slider bar to the right or type in the desired

value.

»  To reduce the number of groups, decrease the value in the slider bar.
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* For the most consistent results between experiments, set the sensitivity level such that
an increase or decrease of 0.3 does not change the results. This will ensure that the
calculations are performed in a robust sensitivity range and can be used in subsequent
experiments.

4. Select the Compute Groups button to complete the analysis.

5. Samples will be color coded by group and displayed graphically as both Normalized Melting
Peaks and Normalized Difference Curves. The groupings are displayed by color both on the
graphs as well as the plate map for easy cross reference.

6. If the Internal Standards grouping option was selected, but only a single reference sample
is used, all the samples that belong to the group containing the reference sample are
grouped together. All the remaining samples are assigned as Unknown (green). To further
cluster the unknown samples into individual groups select the Group Unknowns button in
the Grouping box.

[ ORTCTST T

' s L L s L
L] B B a n T

Magahe Fie| Mo | Gasuping | TioCatiog| Rewts | ot | Bagumnce | Tempeaahne ‘C
— G
e = Mssinalized Malting Pasks
Siasdyrh [Uza btona Barchartr »|  Serihdy [tlamal )
FeratikyLeved o[ 000« | = |
et Lot m\\ =
Iderdty B \ Epliioens |t/ E
Eo Hvaes £
Gaougs [ =l Mpﬁwi na...s...,]_ Aokl _] ‘ §
— EdiCab T
Fikisd ks ool bocharsgsd 41 e Bt dckeoksd bekes ‘E
MaaCo (Aol =] Apek D i
e
C = |
i L L L L ;
L] B B A Ll ™
Temperatne "¢

7. Save the results by going to the File menu and choosing Save.
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The melting temperature (Tm) of a sample is defined as the point in a melting curve where 50%
of the probe-target hybrid is dissociated. The LightScanner software is designed to automatically

<76 >

calculate the melting temperature for every sample.

Megative Filter| Normalize| Grouping| T Calling | Results | Group Names| Sequence |

— Tm Calling Settings

Method: | Automatic Mode v] Selection: | Genotype ']
Sengitivity: ’m
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— Data Digplay
¥ Tm [~ Area ™ width [ Height [T Show Shoulders
— EditCalls

Marked samples will be changed to the type selected below

Mew Call: | auta Call vi Apply Change

— Status

Feady

To calculate the Tm automatically, select the Automatic Mode method, then do the following:

1.

In the Selection box pull-down menu, select Genotype. This option groups samples by the
genotyping assignments made in the previous screen.

Select Normal in the Sensitivity box if you only want to analyze the major peaks. The
Tm may appear to be skewed due to contributions from minor peaks. Select High in the
Sensitivity box if you want to analyze major and minor peaks independently.

Finally, select Compute Tm Values.

The results will be displayed in tabulated form in the Tm Calling Data display below the
graph. For heterozygous samples, an additional calculation of ATm is also displayed.

The data table will display the following data:

TmA1 The melting temperature of the first peak in the sample
Tm2 The melting temperature of the second peak in the sample
ATm The difference in the melting temperatures between the 2 peaks

Data that the software automatically calculates but does not display includes peak area,
height, and width and shoulder regions. This information can be displayed by selecting the
check boxes in the Data Display frame.
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Optional data

Area 1 The area of the first peak in the sample
Area2 The width of the first peak in the sample
Width1 The area of the second peak in the sample
Width2 The width of the second peak in the sample
Height1 The height of the first peak in the sample
Height2 The height of the second peak in the sample

7. Data can be sorted by Group, Row, Column, Name, or Tm by clicking on the column headers.

8. Genotyping calls can be edited based on Tm assessment by using the Edit Calls menu. Right

click + box the samples you wish to edit. Use the options in the pull down menu to select the
new call, and select Apply Change.

9. A summary of all the results is compiled in the Results tab window. These results can be
exported as a tab delimited file for data management purposes. To export the data, go to
File>Export>Genotyping Results under the Menu Bar.

Manual Tm Calling

You can also determine peak area and Tm manually. Manual Tm should be calculated one sam-
ple at a time.

1. Select a single sample from the sample grid.

2. Under Method choose Manual mode. For Labeled Probe Analysis, the Tm Calling Editor
below the graph now displays two check boxes if the peaks option is set at two peaks or

less, and six check boxes if six peaks or less is selected. For Unlabeled Probe Analysis, two
check boxes are displayed.
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3. Checking the boxes immediately brings up a cursor on the screen that can be dragged to any
position on the graph. The position of the cursor is indicated numerically next to the check
box. This is the manually calculated Tm.

4. Tm values are computed in real-time, and the compute Tm values button is inactive.

Directed Auto Mode for Tm Calling

<78>

The Directed Auto Mode is designed for situations where the user knows the expected melting
temperature of the peaks they are interested in. The Tm cursor is placed in the expected region
of probe melting, and the software limits the Tm calculation to the region indicated. This method
can be useful for samples where low allele fractions (or low concentrations of sample) give small
melting peaks that are not recognized by the Automatic Tm calling algorithms. In this case, the
software will search the region surrounding the Tm cursor, look for anything that is considered a
melting peak, and assign a Tm.

The Directed Auto Mode should only be used with a single sample or a cluster of samples with
melting peaks in the same Tm range. If the method is used with samples that have very different
melting temperatures, the software will place the cursors in locations suitable for sample A1 and
calculate and display the Tm based on these regions only.

1. Select a single sample or a cluster of samples with similar Tm for analysis.
2. Select Genotype or Peak Number in the Selection box.

3. Select Directed Auto Mode from the Method pull down menu. This will bring up two check
boxes below the Melting Peaks graph. Checking a box will bring up a cursor on the screen
that can be dragged to the region around which the software should perform the peak search.
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Tm values are calculated in real-time, and the Compute Tm Values button is inactive.

5. Tm values are displayed in the Tm Calling data table. Note that in contrast to the Manual Tm
calling mode, each sample will have a slightly different Tm.

6. Save the results by going to the File menu and choosing Save. Results can also be exported
by choosing Export Genotyping Results from the File menu.

Move to the Results tab to view the analysis in tabulated format. Data is displayed by Row, Col,
Name, and Grouping Call. If a sample has been manually reassigned to a group, it will be marked
by an asterisk to flag it for future reference. These results can be exported in tab-delimited format
(Excel compatible) by going to the File menu and choosing Export Scanning Results. A *.rst file
will then be generated that can be opened with Excel or another spreadsheet program.
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Genotyping with labeled is probes is achieved using either HybProbes or SimpleProbes.
Fluorescence resonance energy between the dyes on adjacent HybProbes generates a signal
that decreases as the temperature is increased. With SimpleProbes, the fluorescence is high
when the dye-conjugated probe is bound to the target strand and is lost as the duplex melts. The
melting transitions that are observed with labeled probes are large, and not confounded by the
presence of the amplicon melting region, therefore it is not necessary to bracket the melt regions
as carefully as required with the unlabeled probe analysis.

In the Labeled Probe application, after background subtraction, melting transitions are displayed
as normalized melting curves and melting peaks representing the negative derivative of fluores-
cence versus temperature (-dF/dT). The Tm values calculated from the melting peaks can then
be used to characterize genotypes.

There are four steps that must be followed when analyzing Labeled Probe genotyping data. The
steps are arranged sequentially in the analysis subtabs on the software, and at each step the
software will present you with best-guess default settings that can be modified if necessary.

The analysis sequence is as follows:

Step 1. Negative filter: Known negatives and failed PCR reactions should be excluded before
the analysis to prevent false positive results. You can identify known false positives manually or
allow the software to determine the negatives automatically

Step 2. Normalize: The melting curves are normalized to have the same beginning and ending
fluorescence and curves are displayed as derivative melting peaks.

Step 3. Grouping: The software automatically clusters samples into groups with similar melting
profiles.

Step 4. Tm Calling: The derivative melting peaks are used to calculate a Tm for each peak.
Heterozygous samples that have two melting peaks have two Tm values displayed per sample.
The difference between the two Tm values (ATm) is also calculated for these samples and can
be used as additional analysis criteria for confirming genotypes.

Move to the Report Tab in the Index Bar to get a final report of your experimental analysis.
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To open a file:

1. Start the software then select Labeled Probe under the Genotyping Analysis section of the
home page.

2. Select a *.mat file to analyze newly collected data or to inspect previously analyzed data,
then select Open.

3. You will be taken to the Negative Filter selection screen of the Analysis window.

Alternatively, you can open a *.mlt file that contains the raw melt data, but you will need to
wait a few moments as the software performs some precalculations. After this, you will be
taken directly to the Subsets window.

The Negative Filter is used to identify any samples that were included on the plate as negative
controls and any failed PCR reactions. It is important to identify negatives before the next analy-
sis step of data normalization to avoid the possibility of generating false positive data. If subsets
have been defined, you must analyze each subset independently. A pull-down menu at the top of
the screen will display the data in the selected subset.

To identify negative samples:
1. In the Negative Filter tab, select Negative from the New Call pull-down menu.

2. Select samples by using right-click + drag to box the selection, or click the appropriate sam-
ple wells in the sample grid.

3. Select Apply Change.
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To set the data range for labeled probes:
1. Move to the Data Range tab.

2. The upper chart displays the full range of fluorescent data for the run. The software automati-
cally performs the background subtraction and places the temperature cursors in a suitable
region for analysis. Visually confirm that the Minimum and Maximum temperature cursors
bracket the region of the probe melt.
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3. The lower chart displays the background corrected derivative melting peaks of the data (-dF/
dT versus Temperature) with an option to display raw melting curves.

Melting Peaks
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4. In the melting peaks graph, you should observe a completely flat region before and after the
melting transition to get the best results.
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If the cursors are located at the outer edges of the graph, pull them in towards the melting transi-
tion by dragging the cursors with your mouse or entering numerical values in the temperature
boxes above the sliders.

The next step of the analysis is to compute the samples into groups based on the melting profile
of the probe. In this tab, the data is presented in two graphs, the upper graph is directly carried
over from the previous screen and can be toggled between melting curves and melting peaks.
The lower graph displays melting peaks only. Also, the upper graph always displays all the sam-
ples in the analysis. The lower graph only displays user selected samples.
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1. To compute the melting data into genotypes, first choose the grouping method from the
Standards pull-down menu. The software offers three grouping options:

* Auto Group—In this setting, samples are grouped by melting temperature with no bias
towards any one group. Up to 10 unique groups can be assigned to a data set.

* Use Internal Standards—in this setting samples are grouped around known standards
defined by the user in the sample editor.

» Use External Standards—in this setting the user has the option of importing external
standards from a previous analysis for use with the current data set. Selecting the exter-
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nal standards option will bring up a file selection dialog from which the user chooses the
file containing the standards that will be brought into the analysis.
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2. Choose the sensitivity. The software offers two sensitivity settings
* Normal—Select Normal sensitivity for peaks that are separated by 3-5 °C.
+ High—Select High sensitivity to distinguish between groups that are separated by less

than 3 °C.
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In general, normal sensitivity should be used for peaks that are separated by 3-5 °C. The High
sensitivity setting may be needed for peaks that are less well separated.

3. Adjust the Sensitivity Level.

Depending on the quality of the data you may need to adjust the grouping calls. The sensitiv-
ity slider bar allows you to adjust the grouping sensitivity to a value that best fits your data.
The grouping call will change in real time as you adjust the slider, but you must select the
Compute Groups button when you have found the desired setting to preserve that analy-

sis. Finding the correct sensitivity is especially important when optimizing a new genotyping

LightScanner Instrument < > System Manual < > Rev 04 <85>



Chapter 9: Genotyping with Labeled Probes

experiment. Once the sensitivity is established for an assay, you should be able to use the
same settings to analyze subsequent experiments.

The default (normal) sensitivity setting is zero.

4. Select the Compute Groups button to complete the analysis.

To reduce the number of groups, decrease the value in the slider bar.

To increase the number of groups, move the slider bar to the right or type in the desired

For the most consistent results between experiments, set the sensitivity level such that
an increase or decrease of 0.3 does not change the results. This will ensure that the

calculations are performed in a robust sensitivity range and can be used in subsequent
experiments.

Samples will be color coded by group and displayed graphically as both Normalized Melting
Peaks and Normalized Difference Curves. The groupings are displayed by color both on the
graphs as well as the plate map for easy cross-reference.

6. If the Internal Standards grouping option was selected but only a single reference sample is
used, all the samples that belong to the group containing the reference sample are grouped
together. All the remaining samples are assigned as Unknown (green). To further cluster the
unknown samples into individual groups, select the Group Unknowns button in the Settings

box.

7. Save the results by going to the File menu and choosing Save.

The melting temperature (Tm) of a sample is defined as the point in a melting curve where 50%
of the probe-target hybrid is dissociated. The LightScanner software is designed to automatically
calculate the Tm for every sample.

<86 >
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To calculate the Tm automatically, select the Automatic Mode method, then do the following:

1.

In the Selection box pull-down menu, select Genotype. This option groups samples by the
genotyping assignments made in the previous screen.

Select Normal in the Sensitivity box if you only want to analyze the major peaks. The
Tm may appear to be skewed due to contributions from minor peaks. Select High in the
Sensitivity box if you want to analyze major and minor peaks independently.

Finally, select Compute Tm Values.

The results will be displayed in tabulated form in the Tm Calling Data display below the
graph. For heterozygous samples, an additional calculation of ATm is also displayed.

The data table will display the following data:

TmA1 The melting temperature of the first peak in the sample
Tm2 The melting temperature of the second peak in the sample
ATm The difference in the melting temperatures between the 2 peaks

Data that the software automatically calculates but does not display includes peak area,
height, and width and shoulder regions. This information can be displayed by selecting the
check boxes in the Data Display frame.

Optional data

Area 1 The area of the first peak in the sample
Area?2 The width of the first peak in the sample
Width1 The area of the second peak in the sample
Width2 The width of the second peak in the sample
Height1 The height of the first peak in the sample
Height2 The height of the second peak in the sample

Data can be sorted by Group, Row, Column, Name, or Tm by clicking on the column headers.

Genotyping calls can be edited based on Tm assessment by using the Edit Calls menu. Right
click + box the samples you wish to edit. Use the options in the pull down menu to select the
new call, and select Apply Change.

A summary of all the results is compiled in the Results tab window. These results can be
exported as a tab delimited file for data management purposes. To export the data, go to
File>Export>Genotyping Results under the Menu Bar.

Manual Tm Calling

You can also determine peak area and Tm manually. Manual Tm should be calculated one sam-
ple at a time.

1.
2.

Select a single sample from the sample grid.

Under Method choose Manual mode. For Labeled Probe Analysis, the Tm Calling Editor
below the graph now displays two check boxes if the peaks option is set at two peaks or
less, and six check boxes if six peaks or less is selected. For Unlabeled Probe Analysis, two
check boxes are displayed.
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3. Checking the boxes immediately brings up a cursor on the screen that can be dragged to any
position on the graph. The position of the cursor is indicated numerically next to the check
box. This is the manually calculated Tm.

4. Tm values are computed in real-time, and the compute Tm values button is inactive.

Move to the Results tab to view the analysis in tabulated format. Data is displayed by Row, Col,
Name, and Grouping Call. If a sample has been manually reassigned to a group, it will be marked
by an asterisk to flag it for future reference. These results can be exported in tab-delimited format
(Excel compatible) by going to the File menu and choosing Export Scanning Results. A *.rst file
will then be generated that can be opened with Excel or another spreadsheet program.

<88> LightScanner Instrument < > System Manual < > Rev 04



Chapter 10: LightScanner Troubleshooting Guide

Troubleshooting Guide for Chemistry

Symptom

Low overall
fluorescence
(the sample
is weakly
fluorescent)

Probable Causes

Plate map not aligned to wells
of plate.

Solutions

Use software alignment tool to align the map
to the plate.

Acquisition of data was started
after melting transition of
fragment had already begun.

Adjust melting window to accommodate the
melting characteristics of fragment.

PCR is not robust.

Assess robustness of PCR by gel
electrophoresis. Adjust reaction chemistry
(MgCl,, primer concentration, etc.) or cycling
parameters (annealing temperature, cycle
number, etc.) to increase robustness of
reaction.

No oil overlay of single or
scattered sample(s).

Set up PCR for those particular sample
(along with needed controls) again.

No oil overlay for entire plate.

Make sure the entire plate is equally
dehydrated (e.g., 90 °C for 10 min. on an
uncovered thermocycler). Rehydrate samples
by adding water and oil overlay. Remelt the
samples.

Nonoptically clear sealing film
on the plate.

Replace with an optically clear film or remove
altogether. See Appendix B for a list of
optically clear plate films.
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Symptom

Inconsistency

Chapter 10: LightScanner Troubleshooting Guide

Probable Causes

Different DNA isolation
chemistries (final elution
buffer, storage buffer) used to

prepare individual specimens.

Solutions

Isolate DNA samples using a common
protocol or bind existing DNA to silica and
elute specimens into a common buffer.

Components of reaction
mixture not consistent
between samples (e.g.,
MgCl, concentration, primer
concentration, adjuvant, etc.).

Re-run with a consistent reaction composition
among all of the samples.

of profiles
between
replicate e . ;
samples or Presence of nonspecific Assess reaction by gel electrophoresis.
samples of amplification products in the Optimize the PCR chemistry and cycling
common reaction. conditions as described in Chapter 3.
genotypes

Inconsistency of reaction . . .

Re-run with a consistent reaction volume.

volume between samples.

Inconsistent template DNA Adjust template DNA specimens to be at a

concentration between common concentration and add equal amount

reactions. to each reaction.

\I?v:ﬁble present in a reaction Centrifuge plate to remove bubble.

e Assess reaction products by gel
Presence of nonspecific : - .
e electrophoresis. Optimize the PCR chemistry

amplification product. . o . .

Unexpected! and cycling conditions as described in

Inconsistent
low
temperature
melting
inflections

Chapter 3. Use a Hot-Start method.

Primer dimer product.

Evaluate primer design and re-design to
eliminate dimer formation. Increase annealing
temperature to make dimer formation less
favorable. Reduce duration of annealing step
to make dimer formation less favorable. Use
a Hot-Start method.
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Symptom

Unexpected/
Inconsistent
high
temperature
melting
inflection
(toeing)

Probable Causes

Presence of non-specific
product having a higher
melting temperature than the
desired product.

Chapter 10: LightScanner Troubleshooting Guide

Solutions

Assess reaction by gel electrophoresis.

If using a previously optimized PCR
reaction, check for degradation of primer(s)
by rediluting from a stock and reassess

the reaction. Synthesize new primers if
necessary.

If using a nonoptimized PCR reaction,
optimize the PCR chemistry and cycling
conditions as described in Chapter 3.

PCR reaction
fails when
LCGreen® dye
is included

PCR inhibition when using
AmpliTaq® Gold or a home-
brew Taq polymerase
enzyme. Occasionally poor
performance has been
observed when using these
enzymes with LCGreen Plus.

Try a different thermostable polymerase
enzyme. The mechanism for the inhibition
remains unclear. Recommended enzymes
include: Klentag™ (AB Peptides), Fast Taq
(Roche), Taqg DNA polymerase (AB Gene,
GibcoBRL). Hot-start procedures, although
not necessary for well-optimized reactions,
are widely recommended because it is easier
to obtain clean PCR products.

Dithiothreatol (DTT) is present
in reaction mixture. LCGreen
when in the presence of DTT
can cause the precipitation of
bovine serum albumin (BSA).
The precipitate is intensely
stained by the dye.

Use a buffer that is missing either DTT or
BSA.

LCGreen dye raises the
annealing temperature of
primers and the denaturation
temperature of PCR products.

Adjust annealing and denaturation
temperature upward to reestablish optimal
PCR.
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<02>

Symptom

Unusual
melting profile
not observed
with sample
known to
contain
heterozygous
sequence
variation

Probable Causes

A polymorphism resides under
an amplification primer. A
polymorphism under a primer
may cause allele specific
amplification leading to the
variant of interest being either
poorly represented or not
represented.

Solutions

Re-design the primer to avoid polymorphic
sites.

Differences in the melting
profiles may be subtle.

Use Difference Plots to compare curves and
make sure samples of the same genotype
cluster well.

Certain SNPs and single
nucleotide insertions/deletions
are more difficult to detect
than others. Longer amplicons
show less deviation from wild
type than shorter amplicons.

Ideal PCR product lengths are 100—-250 bp,
although SNPs in over 1,000 bp products can
be detected.

Melting window is excessively
wide.

Begin data acquisition 2—-5 °C below the start
of the melting transition so that differences
are more readily observed.

Difficulty
analyzing
high Tm PCR
products

For PCR products that melt at
high temperatures, it may be
difficult to completely melt the
products and get adequate
high-temperature background
for analysis.

In this case, consider adding dimethyl
sulfoxide ([DMSQO] 5-15%), either before
(preferred) or after the PCR.

LightScanner Instrument

System Manual < > Rev 04




Symptom

Front panel
Power LED
does not turn
on

Chapter 10: LightScanner Troubleshooting Guide

Troubleshooting Guide for Hardware

Possible Test Solutions
Causes
LightScanner | Make sure power switch is in
is turned off | the on position.
If both occur the LightScanner
Cycle power to the instru- has power, and the problem
ment. Front door will open, may only be with the LED.
LightScanner | and beep can be heard.

has no power

LED fans can be heard hum-
ming for the first 5 sec.

The LightScanner will run
without the LED. To repair
the LightScanner must be
returned.

Cycle power to the instru-
ment. Front door will open,

If neither occurs it is pos-
sible the LightScanner has no
power.

LightScanner and beep can be heard
is unplugged P ) Check that both ends of the
LED fans can be heard hum-
: ) power cord, and ensure both
ming for the first 5 sec. X ; ;
are firmly seated in their
respective sockets.
If neither occurs it is pos-
sible the LightScanner has no
power.
Cycle power to the instru- Check fuses; With in power
LightScanner | ment. Front door will open, switch in an off position and
fuses are and beep can be heard. the instrument unplugged,
blown LED fans can be heard hum- | remove fuse cartridge (light

ming for the first 5 sec.

tan square, directly above the
power switch). Wire in center
of both fuses should be intact,
and no burned or dark areas.
Replace if necessary.

Note: If you are still unable to operate the LightScanner instrument, please contact Idaho

Technology’s customer service department.
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Possible

ST Causes

Serial cable
is loose or
unplugged.

Test

Verify that the serial cable
(9-pin) is firmly seated in its
respective connector on the
back of the LightScanner ,
and the serial port (Com Port
1) of the PC.

Solutions

Re-seat cable.

Run Software
returns com-
munications
error

Software
Conflict.

Open PC task manager and
make sure no other programs
are running that might be try-
ing to access Com Port 1.

Make sure multiple instances
of the LightScanner Run
Software are not running

Close extra application, and/
or reboot.

Serial cable
damaged or
broken
Note: this is
unlikely to
occur

If a spare serial cable is
available try using it.

Order a replacement cable
from Idaho Technology.

9 Note: If the serial cable is properly seated, and you are reasonably sure there are no soft-
ware conflicts, consult any possible software fixes/troubleshooting tips that may be available. If
you are still unable to operate the LightScanner instrument, please contact Idaho Technology’s

customer service department.

Camera
Internal Blue
s Cable
Excitation loose or
LEDs do not .
disconnect-
turn on ed

Verify that the camera cable
is firmly seated in its respec-
tive connector on the back
of the LightScanner and the
PC.

There should only be one
connection on the back of
the LightScanner and PC
where this cable will fit.

Re-seat cable.

Note: If the camera cable is firmly seated in both the LightScanner and PC, follow any
camera troubleshooting instructions you might have.
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Symptom

Melting Data
has large
spikes or
fluctuations

Chapter 10: LightScanner Troubleshooting Guide

el Test Solutions
Causes
Poor If ITI test plate looks good,
. Run test plate from ITI. the problem is likely to be
chemistry ) .
from the end user’s chemistry.
If ITI test plate looks bad, the
Defective problem is likely to be from
: Run test plate from ITI. the LightScanner, and the
LightScanner ; .
instrument will need to be
returned for repair.
Bubble
presenft in Run test plate from ITI. Centrifuge plate to remove
a reaction bubble.
well.

Returnable Problems

The problems listed below are indicative of a LightScanner hardware failure and are not diag-
nosed or repaired without the use of LightScanner Service Software and a trained technician.

If you encounter any of these issues or any undescribed failures, please contact ITI Technical
Support for assistance.

*  Door will not open/close.

«  Temperature does not change.
« Lifter and ejector motors make abnormal noises or movements.
* Fans not turning on.
« Half of the plate image is very dim.
« Bar code reader not functioning.

*  Blue excitation LEDs remain on after run is complete.
«  Ejector will not return plate.

¢ Plate will not auto load.
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Appendix A: File Formats

The LightScanner software creates various types of files as part of a LightScanner experiment.
Each file is named using the experiment name, plus an extension that identifies the file type.
Extensions include the following:

.mit

.mat

flo

.rst

.smp

.tem

.cur

.vs2

A file containing the raw melting data from an experiment. The *.mlt file is created automati-
cally when you run an experiment, as soon as the experiment is completed the software will
perform a series of data pre-calculations that result in a *.mat file which should be opened to
complete the analysis. A *.mlt file can also be opened in the analysis software however; the
software will need to re-compute some of the calculations before the data file can be opened.
Most users will prefer to save time by opening the *.mat file directly.

An analysis file generated after completion of an experiment. The *.mat file should be opened
in order to complete the data analysis. Once the data analysis is complete you can save the
file and retain all the analysis settings. You can also use the settings associated with a par-
ticular mat file to provide the settings for another experiment by importing analysis settings
through the file menu. This allows you to apply a standard set of analysis parameters to all
your experiments if required. (Note, negatives must be re-defined in every analysis, they are
not imported with the settings.)

A Important: Do not open the file or adjust it in any way other than through the
LightScanner software. Doing so can cause loss of data and other problems. You can
rename the .mat file, if desired.

A fluorescence file containing fluorescence data from a LightCycler® experiment. You can
import a .flo file and perform an analysis of the data.

A result file containing the results of an analysis. The file is generated when you select Save
Results from the LightScanner file menu after you compute genotypes.

A sample name file containing the names and locations of samples in your experiment. You
can create the file, then import it to provide sample name information for the current experi-
ment.

A temperature file containing the raw temperature data.

A tab-delimited file containing data for temperature and melting curve values. The first column
in the file contains the temperature readings. The remaining columns contain the melting curve
data in a column-oriented format: The second column contains fluorescence values for well
position A1, the third column contains fluorescence values for well position B1, and so on.

A fluorescence file containing fluorescence data from a HR-1™ experiment. You can import a
flo file and perform an analysis of the data.
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Appendix B: LightScanner Plate and Sealing Film Compatibility

/A\CAUTION: Use only white-well plates with the LightScanner. Clear plates allow fluorescence bleed
over from well to well, and black plates quench fluorescence and increase noise.

Note: Compatibility list is subject to change. Check ITI Web site for updates and additional
information.

Manufacture 96-Well Plate 384-Well Plate Sealing Film

Axygen PCR-96M2-HS-We UltraClear™ UC-500°°
www.axygen.com

Bio-Rad HSP-9665° HSP-3865t Microseal® ‘A’ Film — MSA-5001
www.bio-rad.com MSP-9651 MSP-3852 223-9444bcd

GeneMate by ISC BioExpress | T-3078-W¢ T-3157-W

www.bioexpress.com T-3109-W

Applied Biosystems ABI PRISM™ Optical Adhesive
www.appliedbiosystems.com Covers — 4311971

4titude® FrameStar® 964ti- | Framestar 3844ti-0385

www.4ti.com.uk 0961 (Black frame | (Black frame white well)

www.bioke.com white well)®

Phenix MPX-96M2-Wa

www.phenixresearch.com

G. Kisker GbR GO060/H/IE-We

www.kisker-biotech.com

MBP 3482W

www.mbpinc.com

ABGene AB-0800/W AB-1170b¢

www.abgene.com

2aCompatible with the Applied Biosystems GeneAmp® 9700 Thermal Cycler (Please note that all plates compatible with
the 9700 give a significantly reduced fluorescent signal)

Preferred plate or sealing film

°Film may remain intact during melting analysis. (Please note that use of this film does not eliminate the need for an oil
overlay.)

dAvailable by phone order only.
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Compatible Mineral Oils

<100 >

Manufacture Catalog No. Mineral Oil

Sigma M5904 Mineral Qil Light for Molecular Biology
www.sigmaaldrich.com

Fisher 0121-1 Mineral Oil Light

www.fishersci.com

Alfa Aesar 31911 Mineral Oil

www.alfa.com

uUsB 71600 Ultra Pure Mineral Oil - Molecular Biological Grade

www.usbweb.com

A\IMPORTANT: The use of mineral oil is required to prevent sample evaporation in the

LightScanner.
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Appendix C: Preventing Carry-over (Amplicon) Contamination

To achieve the best PCR results, it is essential to prevent amplicon contamination. There are both
physical and chemical methods used to prevent contamination.

Physical Methods

Many thermal blocks are equipped with heated lids or covers which theoretically prevent sample
condensation, evaporation, and loss during PCR cycling. To ensure sample volume retention and
prevent contamination, all samples should be covered with a layer of mineral oil, and the plate
should be sealed with a clear film or aluminum foil tape.

These measures are necessary for genotyping on the LightScanner for the following rea-
sons:

1. The plate of reactions must be removed from the thermal block and spun down at 2000 rpm
for 1-2 min. following PCR. This is a critical step, as air bubbles are often present following
PCR and must be spun out of the reaction before analysis on the LightScanner. Some type
of physical barrier is necessary when transporting the plate of amplified reactions from the
thermal block and during the centrifuge spin.

2. The oil barrier helps reduce the risk of amplicon contamination and prevents the amplicon
sample from evaporating. There are several brands of film that are optically clear, which
may be left on the plate during melting. Use of these optically clear films is recommended,
because they do not have to be removed during melting, thereby reducing amplicon con-
tamination risk.

Chemical Methods

PCR is capable of amplifying a single molecule over a million fold. Even the most meticulous lab-
oratory can experience some degree of amplified product carry-over into the “clean” PCR setup
area. Amplicon contamination risk can be minimized by adding uracil-DNA glycosylase (UNG)

to the reaction mix if dUTP has been substituted for dTTP. UNG catalyzes the removal of uracil
from single- and double-stranded DNA that has been synthesized in the presence of dUTP (but
does not degrade native DNA or PCR primers). Therefore, UNG is only effective in contamination
prevention if dUTP was substituted for dTTP at the inception of the assay.
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APPENDIX D

RETURN PROCEDURES

An instrument problem may be reported by calling, faxing, e-mailing, or mailing Idaho Technology.
The contact numbers are located below.

If you are returning an instrument for repair, follow the basic guidelines prescribed in this appen-
dix. You will also need the following documents:

Declaration of Decontamination
Decontamination Labels

These forms and instructions can also be downloaded from http://www.idahotech.com/prod-
uct_sup/index.html.

Phone

(800) 735-6544 - United States and Canada
(801) 736-6354 - Utah
+1-801-736-6354 - International

Fax

(801) 588-0507 - United States and Canada
+1-801-588-0507 - International

E-mail

support@idahotech.com - Technical Support

Web Site
http://lwww.idahotech.com/product_sup/index.html

Address

Idaho Technology, Inc.
390 Wakara Way

Salt Lake City, UT 84108
USA
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Step 1: Obtain a Return Materials Authorization Number

The first step in returning an instrument to ITl is to obtain a Return Materials Authorization (RMA)
number from our Service Department. You can either call Technical Support at 1-801-736-6354 or
1-800-735-6544 or complete the supplied fax forms (two pages) and fax them to ITI. A Technical
Service specialist will contact you with an RMA number and further instructions. If your instrument
is still under warranty, please supply the purchase date and serial number, if your instrument is
out of warranty, please supply a blank PO# for the repair charges.

Step 2: Decontaminate All Returned Equipment

You must decontaminate all equipment being returned to ITI to remove amplicon contamination
and to ensure that personnel handling the equipment are not harmed by pathogenic organisms.

The person responsible for the return must thoroughly decontaminate the unit by follow-
ing the instructions below and in “Cleaning and Decontamination,” of Chapter 1, Installing the
LightScanner Instrument.

Chemical Lab Decontamination

If a chemical lab makes the return, the customer must thoroughly clean chemical contamination
from the instrument.

Biological Lab Decontamination

If the instrument was used in a clinical lab, the person responsible for the return must thoroughly
decontaminate the unit by wiping it down with a 10% bleach solution (chlorine bleach diluted 1
part bleach to 9 parts water), followed by wiping it down with distilled water to remove any con-
taminants. Be sure not to mix the bleach solution with other chemicals (mixture with acid will liber-
ate chlorine gas). Since the solution is caustic, gloves and a face shield are recommended when
preparing and using the solution. When corrosion by the 10% bleach solution may be a problem,
flush with water is permissible after the 10% bleach solution has remained in contact for a mini-
mum of 10 min.

Step 3: Decontamination Labels

After the above steps have been completed, the person responsible for the return must complete
and sign two decontamination labels and attach one to the instrument and the other to the exte-
rior of the shipping container. Complete and sign the Declaration of Decontamination form; a pho-
tocopy should be made for your records and the original must be returned with the instrument.

@ Note: An RMA number must be obtained from ITI before shipping. The RMA number and decon-
tamination labels must be visible on the exterior of the shipping container.

ITI reserves the right to return or refuse receipt of any materials at the customer’s expense that
do not meet these requirements.

Step 4: Packaging and Shipping

1. Package the instrument inside a large heavy weight box.
2. Put all extra components in a separate box and place the instrument into the box.
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3. Put the accompanying computer and monitor in a heavy weight box, seal it with packing
tape, and place it in a shipping box.

4. Fill all sides and top of the shipping box around the instrument with at least two inches of
instant packing foam, or packaging material for protection against shipping damage.

5. Seal the box with packaging tape.

International Shipping

If an instrument is shipping internationally, the instrument MUST have an export license.
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RETURN MATERIALS AUTHORIZATION FAX pc. 1 OF 2

This form may be faxed to our return center at 1-801-588-0507 (U.S. and Canada) or +1-801-588-
0507 (International). It must also be included with the returned instrument.

If your equipment is still under warranty, please supply the purchase date and instrument serial
number. If your instrument is out of warranty, please supply a blank PO# for the repair and shipping
charges. Please note that your item must be returned with a ITl assigned RMA# and decontamina-
tion documentation.

From: Pages:

Attn.:

Ship to: Idaho Technology Inc. Warranty:
390 Wakara Way
Salt Lake City, UT 84108 Nonwarranty:
USA

Date:

RMA# (required when returning an instrument)

Company:

Department: PO#:

Phone: Fax:

Model: Serial No.

Laptop Login and Password (needed to QC test the LightScanner system):

Notes:

The decontamination form and labels must be completed before the instrument is returned to Idaho
Technology. If the unit is returned without decontamination documentation, it will be shipped back
to you at your expense. Nonwarranty charges are standard labor charges with a 2-hour minimum
charge plus parts and shipping charges. If the unit cannot be repaired, it will either be returned to
you or disposed of upon your request. Thank you for your business and for supporting the health
and well being of our employees.

Signature: Date:
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RETURN MATERIALS AUTHORIZATION FAX PG. 2 OF 2

SRR EEEA AR AR RN A SRR AN NN AN NI AN NN

Declaration of Decontamination

This instrument has been decontaminated according to established Idaho Technology Inc. bio-
logical decontamination procedures.

Which method was used?

What chemical, infectious, toxic or radioactive substances have been in contact with this prod-
uct? (Also indicate if flammable or corrosive.)

Authorization Notice

By accepting this authorization to return this product, the user assumes all responsibility for
decontamination and cleaning. Idaho Technology Inc. reserves the right to refuse the delivery
of products, which do not appear to have been properly decontaminated. If the equipment was
used with or around radioactive material, the signature of the safety officer is also required.

mmmmmmmwé

RAMNMNNNTNTNTITNS

Signature: Date:

R

2

mmmmmmmmmmmmmmmwé
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Decontamination Labels

Please complete these Decontamination Labels and affix one to the instrument case and the
other to the exterior of the shipping carton. Failure to decontaminate before shipping to ITI will
result in the immediate return of the unit at your expense.

Copy and cut out the label and attach it to the case of the instrument being returned.

[ 7 |
DECONTAMINATION NOTICE:

This Product has been decontaminated per Return Equipment policy:

Idaho Technology Return Authorization (RMA#):

Customer Name:

Customer Address:

Signature: Date: [/

Copy and cut out the label and attach it to shipping container of the instrument being returned.

[ 7 |
DECONTAMINATION NOTICE:

This Product has been decontaminated per Return Equipment policy:

Idaho Technology Return Authorization (RMA#):

Customer Name:

Customer Address:

Signature: Date: I/
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Appendix E: Additional Optimization Considerations

Hi-Res Melting may be performed in any standard PCR buffer. The PCR buffers offered by ITI
provide some advantages. These buffers do not contain KCI, which may be beneficial when
amplifying fragments (usually below 400 base pairs) frequently assayed by Hi-Res Melting. The
second advantage ITI buffers offer is that they are provided in 10X MgCI, concentrations of 10
mM, 20 mM, 30 mM, 40 mM, and 50 mM. Buffers having different concentrations of MgCl, are
useful for developing and optimizing new or existing PCR reactions. Changing the magnesium
concentration is achieved with alternative buffers. Intermediate concentrations may be obtained
by mixing buffers. For example, if a final concentration of 1.5 mM MgCl, is required, equal
volumes of the 10X buffers containing 10 mM MgCI, and the 20 mM MgCl, may be combined
to generate a 10X buffer with 15 mM MgCI, that provides a working concentration of 1.5 mM
MgCl,. Without experimental data, it is impossible to determine what MgCl, concentration will
work best with a new primer set. Having pre-made buffers with a range of MgCl, concentrations
is convenient.

It is recommended that dNTP’s be used at 200 uM each. An acceptable substitute for dTTP is
dUTP. When dUTP is used, the concentration is typically 600 uM (opposed to 200 uM dTTP).
Fragments containing deoxyuracyl melt at a lower temperature compared to the same fragment
containing deoxythymidine.

For Hi-Res Melting applications, hot-start procedures are recommended. Options for hot-start
include antibody-mediated hot-start and thermal activated enzymes.
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High performance liquid chromatography (HPLC) purified primers are recommended. Where to
obtain oligonucleotides is based upon personal preference and the history of individual laborato-
ries. IT BioChem, a division of Idaho Technology, provides current good manufacturing practice
(cGMP) HPLC purified primers that perform well in Hi-Res Melting. Properly quantifying primers
is critical to effective amplification. Beginning with the guidelines provided by the manufacturer,
resuspend primers at 1.5- to 2-fold higher than your desired concentration. Measure the concen-
tration by spectrophotometry and adjust accordingly. Resuspend primers in buffer such as MOPS
(Tris, 3-[N-morpholino] propanesulfonic acid), or HEPES (4-[2-hydroxyethyl]-1-piperazineethane-
sulfonic acid) used at 2-10 mM. The pH should typically be 7.1-8.3. So-called TE buffer (10 mM
Tris, 0.1 mM EDTA [ethylenediaminetetraacetic acid]) is acceptable.

Primers containing 5' GC clamps are frequently employed with presequencing gene analysis plat-
forms such as single-strand conformational polymorphisms and dHPLC. The use of GC clamps
has not been demonstrated to provide any benefit in Hi-Res Melting.

Genomic DNA

Hi-Res Melting compares profiles from independent PCR reactions; therefore, minimizing reac-
tion-to-reaction variability is pivotal. To minimize variability, standardize the template DNA by

*  Quantifying DNA samples using spectrophotometry
» Using a common buffer for all samples

* Adjusting samples to a uniform concentration

* Using the same amount of template in each reaction

For Hi-Res Melting, 10-30 ng of template DNA in a 10 pL reaction volume is recommended.
Archival genomic DNA (material stored frozen for an extended period) presents unique chal-
lenges. Sublimation, the direct transition of frozen material to gas, frequently occurs in archived
samples, and concentrates the DNA, salts, and other material that affect both amplification and
Hi-Res Melting. Repurifying archived DNA by binding the DNA to silica and eluting it into a fresh
buffer improves the quality and leads to better PCR and Hi-Res Melting. Numerous kits are avail-
able to purify DNA, and their performance is largely equivalent. Gel filtration chromatography is
also acceptable for repurifying DNA.

Annealing Temperature

<112 >

The use of gradient PCR is a useful tool for quickly optimizing PCR cycling conditions. Annealing
temperature is the aspect of thermal cycling having the most influence upon specificity and
robustness of amplification.

The figure below demonstrates the necessity of determining an appropriate annealing tem-
perature for generating robust and specific PCR. Gradient PCR was used to amplify a 319
base pair fragment containing the 4th exon of the human SCARB1 gene. The software that
designed the primers indicated the forward and reverse primers to have Tm values of 58.6 and
58.2 °C, respectively. Two primer concentrations were tested: either 0.2 uM of each primer

or 0.3 uM of each primer. Common to all reactions was 1X buffer, 1X LCGreen Plus, 200 yM
each dNTP, 2 mM MgCl,, and 1 unit of Klentaq polymerase in a complex with TaqStart® anti-
body. Cycling conditions were as follows:
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Cycle Time Temperature
Target temperature | 1 min 94 °C
45 cycles 10 sec 94 °C
Annealing 30 sec 60-72 °C

10 sec 72 °C

4% Agarose (HR)

M123456789101112131415161718192021222324

Reaction product was analyzed by gel electrophoresis using a 4% agarose gel. Lanes 1-12
analyzed reactions containing 0.2 uM of each primer, while lanes 13—-24 analyzed reactions
containing 0.3 yM of each primer. At low annealing temperatures (lanes 1-3 and 13), the spe-
cific product is poorly represented, and undesired amplification products are observed. As the
annealing temperature increases the 319 base pair, specific product becomes more prominent
until it is the only product observed (lanes 6-12 and lanes 20-24). Specific product is observed
between 65.2—72 °C using 0.2 uM each primer and between 67.2-72 °C using 0.3 uyM each
primer. Note that robust product is observed at 72 °C, which is 14 °C beyond what the software
predicted to be the Tm of the primers. Salts, LCGreen PLUS dye, and adjuvant (DMSO," glyc-
erol, etc.) also affect Tm.

If a thermal cycler with gradient capabilities is not available, a simple option is to begin by using
conditions that will not overly tax the primer set.

1. Begin with a 10 pL reaction using the following:

* 1X reaction buffer

*  2mM MgCl,

» Arrelatively high concentration of each primer (0.3-0.5 yM)

«  1X LCGreen Plus

* 10-30 ng of template DNA

* Hot start enzyme (investigators' preference of enzyme and hot-start mechanism)

2. Choose cycling conditions where the annealing temperature is at or slightly above the aver-
age estimated Tm of the primers.

3. Place a 1-2 min hold at 94 °C at the beginning of the amplification program and use 35-45
cycles of PCR.

4. Recover samples from the plate and assess them by gel electrophoresis. Based upon the
outcome of the initial experiment, it may be necessary to change the annealing temperature.

LightScanner Instrument < > System Manual < > Rev 04 <113 >



Appendix E: Additional Optimization Considerations

The amount of specific product, the presence or absence of undesired product, and the presence
or absence of dimer product will dictate to the investigator how to best proceed in optimizing the
reaction. If undesired product is observed, the annealing temperature may be increased. If ampli-
fication is not robust, the annealing temperature may be decreased and/or the duration of the
annealing step may be increased. To complete the optimization process, use the following steps.

1. Extension Phase: The extension step in the PCR cycling protocol may be adjusted. In
Hi-Res Melting, the fragments assayed are typically short (500 base pairs or less). Extending
fragments of these lengths requires a hold at 72 °C for 5-20 seconds. If the annealing tem-
perature in the cycling program is 65 °C or above, it is often possible to eliminate the exten-
sion step altogether. In the figure above, the range of temperatures, where only the specific
product is observed (65-72 °C), would likely enable the extension step to be eliminated.
Two-temperature cycling conditions (2-step PCR) promote specific amplification with the
added benefit that programs run in less time.

2. Cycle Number: Increasing or decreasing the number of PCR cycles is useful to generate
specificity and robustness in the amplification. If the PCR is robust with 45 cycles of PCR,
lowering the number of cycles may be an option. At times increasing the number of cycles is
useful to make amplification more robust. When PCR was in its infancy, it was believed that
cycling more than 30-35 times would promote amplification of undesired products. There is
some truth to this belief, but it is not entirely correct. In the past, it was not uncommon to
use 100-500 ng of template DNA per reaction where today 5-20 ng is standard. Excessive
template DNA will cause undesired product to be amplified the same way excessive primer
concentration will lead to amplification of undesired product. Additionally, the quality of oligo-
nucleotide primers has improved dramatically making amplification more specific and robust.
Current Taq polymerases show superior and reliable processing compared to enzymes 10
years ago. All of these features mean more reliable PCR. Also, using more cycles (40-50)
may be done without overt fear of creating undesired product. Reluctance to use more PCR
cycles results from the time when the overall process of PCR was less understood and both
reagents and instruments were less advanced than those available today.

Primer Titration

Depending on the amount of specific product observed in the initial experiment, run a dilution
series of your primers. If the specific product is robust, try titrating the primers downward. If the
specific product is weak, try titrating the primers upward. Use 0.1 uyM increments in the titration.

Determining Magnesium Chloride Concentration

<114 >

Adjusting MgCl, concentration helps improve the specificity and robustness of PCR. If dimer prod-
uct or undesired product is observed, decrease the MgCl, concentration. This makes conditions
more stringent. If undesired product is not observed, increase the MgCl, concentration to increase
robustness. When PCR is performed in capillaries, it is not uncommon to use up to 5 mM MgCl,

but this concentration is rarely used when PCR is performed in block style thermal cyclers. While
the use of MgCl, above 2.0 mM is infrequently seen when PCR is performed in thermal blocks, our
observations indicate that higher MgCl, concentrations can be used to create more robust amplifica-
tion. It is worth the effort to try higher MgCl, concentrations with some reactions.

The amount of MgCl, in a reaction will affect the shape and Tm of the melting profile. We have
observed that some fragments that melt with a single inflection at low MgCl, concentration may
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melt with multiple inflections at high MgCl,. While this was observed with a small number of frag-
ments, investigators should be aware of this possibility. As a general rule, in a higher MgCl, con-
centration, a fragment will melt with a slightly higher overall Tm.

Addition of Adjuvants: To obtain robust and specific PCR, the user may want to use an adju-
vant in the PCR reaction. We have used LCGreen Plus with DMSO, TMSO (tetramethylsulfoxide,
sulfolane), KCI, and glycerol. Currently, these reagents have not affected fluorescence intensity,
altered dye binding characteristics, or made it difficult to detect sequence variation.

DMSO is commonly used to amplify regions of high G:C content by relaxing the stability of the
hybrid. The adjuvant is typically used at 5-15% of reaction volume.

TMSO helps enhance specificity and robustness of PCR. The precise mechanism for the reaction
is not well understood, but its efficacy can at times be quite remarkable. TMSO is solid at room
temperature but liquefies when incubated at 40 °C. Liquefied TMSO is diluted in water (10-30%
stock solution) and typically used at or below 3% in the PCR reaction cocktail.

The salt KCI enhances amplification and has been extensively used to optimize multiplex reac-
tions. Some PCR buffers come with KCI, while others (such as Idaho Technology buffers) do

not. The typical 1X concentration of KCl is 15 mM, but this can be significantly increased (up to

5 fold), decreased, or eliminated altogether. Increasing KCI may be used to enhance amplifica-
tion of short products (<400 bp) while reducing KCI may enhance amplification of longer products
(>600 bp).

Using Hi-Res Melting, the LightScanner instrument can also rapidly assess an entire gene for
sequence variation. To assess multiple fragments, it is necessary to develop a common PCR
condition and melting protocol that accommodates all of the individual fragments. The figure
below shows part of the process to develop an assay for the human N-acetylglutamate synthase
(NAGS) gene. The gene contains 7 exons, but exon 1 was assayed as 2 overlapping fragments,
hence the 1a-1b nomenclature.

Panels (A) and (B) show gradient PCR for the exon 1a fragment and exon 5 fragment. Similar
experiments were performed with the remaining 6 fragments of the panel. A compromise cycling
condition of 1 min. at 94 °C, 45 cycles of 10 sec. at 94 °C, and 30 sec. at 70 °C was determined.
Internal reaction chemistry for individual PCR reactions was optimized.
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Panel (D) shows the melting profiles for the 8 fragments used in the NAGS assay panel. The 8
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Using LightCycler and HR-1™ (optional, Part No. HR01-ASY-0001): The LightCycler and the
single sample HR-1 Hi-Res Melting instrument are useful tools for assay development. The real-
time PCR curves generated by the LightCycler are useful for optimizing PCR reactions, but are
not an acceptable replacement for gel electrophoresis. Differences in amplification efficiency that
are not readily observed in an ethidium bromide stained gel are obvious in the real-time curves
provided by the LightCycler. Amplification protocols in the LightCycler are fast compared to what
is possible with a block-style cycler, which expedites assay development. PCR in a LightCycler
and a block-style cycler are different, but despite this, conditions determined in a LightCycler may
directly transfer to the block-style cycler.

<116 >

LightScanner Instrument < > System Manual < > Rev 04



Appendix E: Additional Optimization Considerations

The HR-1 is useful for determining the characteristics of a fragment so that the shape of the
curve and melting points are known before large experiments in the LightScanner are carried out.
The use of a LightCycler and HR-1 save time and labor but are not required.

Unlike other methods for pre-DNA sequence gene scanning, the PCR product used for Hi-Res
Melting may be recovered for subsequent forms of analysis. The ability to recover the PCR prod-
uct and use it in other types of analysis is unique to Hi-Res Melting. Following melting, the PCR
product may be used for agarose gel electrophoresis or DNA sequence analysis. In both cases,
the PCR product is handled the same as any other PCR product being used for these purposes.
To use the PCR product as template for DNA sequencing, the product must be purified to remove
primers and dNTPs. Essentially any standard procedure is applicable. The dye LCGreen Plus
does not interfere with sequencing reactions or the subsequent sequencing read. For analysis by
gel electrophoresis, tracking dye is added and the sample analyzed with an agarose or polyacryl-
amide gel. LCGreen Plus does not alter mobility or interfere with ethidium bromide staining. While
no experimental evidence exists concerning subcloning of dye-stained PCR product, there is no
reason to suspect these fragments could not be cloned into plasmids or other vectors.
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